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The Getting Started manual  provide detailed instructions
for installing and using Mailware:

How to Install Mailware  - Step by step instructions for
installing Mailware on a single PC or a network.

Getting Started  - A guide to the tutorials, and a quick
start section for experienced users.

Using Mailware  - An introduction to the basic features in
Mailware, and how to use them.

The Reference  sections provide specific information about
the various features in Mailware:

Definitions  - A glossary of terms used in Mailware.

Instructions  - How to complete tasks in Mailware (e.g.,
add a customer, take an order etc.).

Also included are sections for special features (like the
report writer), and quick reference material (e.g.,
Troubleshooting, Shortcuts etc.).

In addition to the manual, Mailware contains extensive help
files which you can access at anytime with the F1 key.
Online tutorials are also available by choosing Tutorials
from the Help  text menu item.

ABOUT THE REFERENCE SECTION

Information in the Reference section is provided in 2 parts. 

First, Definitions  for terms and concepts used in Mailware
are presented. For example, Advertisements are defined as
any form of communication your company uses to sell its
products - from conventional space ads to Internet banners.

The second section provides Instructions  for performing
tasks in Mailware. For example, to Add a Customer, you
select the Customer table from the Company Database,
click the Add to button, then start typing the customer’s
name, address etc. 

Details about fields you will encounter are provided under
Field Definitions section in the instructions for each task.
Obvious fields (like Customer Name) are not listed.

The Instructions section may also contain tips and shortcuts
you can use to save time, improve the quality of your data or
provide greater functionality from your input.

To make looking up the task you are interested in easier,
items are listed in alphabetical order in each section.
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ACTIONS ADVERTISING SOURCE KEYS

Actions are automated processes that make daily functions You are probably already using source keys. They are
easier. For example, if you choose Process Open Orders simply identification codes you assign to an advertisement.
from the Actions tab in the Company Database form you will You use them to track where your customers found you.
be given choices for printing labels, and invoices, shipment
methods and costs, and other functions associated with Mailware makes extensive use of source keys. An Original
order fulfillment. Source Key is assigned to a customer the first time they

ADVERTISEMENTS

Traditional ad tracking measure the number of people who
contact you when they see your ad. This Response Rate is
an important measurement of an ad's effectiveness, but it
does not tell the whole story. Often ads that have lower
response rates are more profitable than other ads because
they bring you better customers who spend more and buy
frequently. Even ads that start off losing money may bring
these better customers, and become your true bread
winners.

Mailware knows this, and uses Advertising Source Keys to Whenever you add a customer Mailware assigns a
effectively measure the success of your ads. Every time you sequential, system number (i.e., 1,2, 3 etc.). This number is
place an ad you should assign it a source key. Then when visible as the System ID# on the Additional Info tab of the
customers contact you the first time, assign them an Original Customer screen. To avoid duplication, it cannot be
Source Key. Each time the same customer contacts you changed.
again you can assign additional source keys to their
account. Mailware uses this information, and the cost of your You may, however, assign your own number by manually
ads, to determine if they are making money. Without this entering it as an Alternate Customer Number. The alternate
information you may find your company pumping valuable number will replace or accompany the system assigned
resources into those high response rate ads that may be number on invoices, labels etc., and may be up to 12
less profitable or may actually be losing money. characters long.

contact you. Subsequent source keys assigned to that
customer tell you which offers are pulling responses. You
can assign additional keys to customers when taking an
order, or in the Customer Contact Log.

Each time you place a new ad, assign a source key to it.
Mailware will return the favor by telling you which ads are
profitable, and which are losing money. You can also group
source keys into Projects to measure the success of an
entire ad campaign.

ALTERNATE CUSTOMER NUMBER
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You may also create an Alternate Customer Number catalog to measure its effectiveness when sent to different
Formula to have Mailware automatically assign unique customers, or at different times.
numbers based on each customer's information.

The Alternate Customer Number may be up to 12 characters
long.

BACK ORDERS

When you add an order to Mailware any items you enter that Invoices, labels etc.), and to define your database.
have a quantity of zero in the Products table will be
automatically back ordered. A dialog will pop up to confirm
the back order, and will include stock level information.

To avoid back orders for items you do not stock, enter a
quantity for the In Stock field (on the Stock Levels tab of the
Products form). You may also wish to check the Drop Ship
Item check box (on the Product tab in the Products form).
The Drop Ship Item field when checked will contain a value
of TRUE in your database. This is used by the report writer
to create purchase orders to your drop ship vendors.

Note: Future versions of Mailware may include the ability to
override the automatic back order function in Order Entry
when the drop ship item check box is checked.

CATALOG

Most ads offer one or two items for sale. Catalogs typically card software and transmitted for approval.
offer many items. Mailware treats catalogs like any other
advertisement, including the assignment of source keys.
However, you may assign several source keys to the same

COMPANY INFORMATION

When you start Mailware the first time you are prompted to
enter information about your company, including its name,
address etc. You can change this information in Preferences
at any time. Mailware uses this information in reports (e.g.,

CREDIT CARD

You can set up credit cards to select when taking orders.
The card type will be selectable in the payment information
portion of the order form. You can also add information
about your merchant services provider for each card.

Note : Mailware supports various credit card processing
software packages. Some are supported with export reports
that create files which can be imported into your credit card
software for batch approvals. Other packages are integrated
with Mailware so you can obtain immediate approvals while
Mailware is running.

Full integration means you can run your credit card software
directly from within Mailware. Export utilities create a batch
file of each day's orders that can be imported into your credit
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CUSTOMERS

Because your customers are so valuable, Mailware
maintains an extensive amount of data on each one.

When you first add a customer you may specify a Customer
Type, an Original Source Key, and an Alternate Customer
Number.

As you update the customer's account (for example, when
you take an order), Mailware updates your database to
reflect the new activity. Mailware also maintains a full history
of your customers' orders including payment methods,
products purchased and Advertising Source Keys. You can
see this information for any individual when you view a
customer's history. When you add a customer, or edit a customer, you may add

The Customer Contact Log gives you a tool for tracking Inquiry type by default when you add a customer, and the
customer service issues. It is also an invaluable resource for Ordering type when you take an order. The type is
regularly contacting your customers using tickle dates to automatically updated by Mailware each time you enter new
remind you to send catalogs, fill repeat orders and more. customer information (e.g., When you enter an order for a

In addition to managing individual accounts, you can Import
and Export customer data. This makes using rented mailing The Customer Types are:
lists or renting your own House List easy and profitable.
Customer information can also be used by the Selects Mailing : Customers whom you are contacting with a direct
function to create targeted mailing lists, and reports. mailing.

CUSTOMER CONTACT LOG

A contact log is associated with each customer, and is
visible when you view a customer's history. It can be used to
document conversations, schedule mailings for individual

customers, or as a reminder to complete any task in the
future thanks to its tickler function.

The Tickle Date field allows you to enter a date to complete
a task. All tickler items due are shown on a tickler report
which you can print daily. This is a handy tool for customer
service, and for other routine tasks like mailing collection
notices, filling book club type orders, sending catalogs,
tracking Return Merchandise Authorization (RMA) numbers,
etc. It is designed to be flexible to meet as many needs as
possible, so feel free to use your imagination.

CUSTOMER TYPE

an entry to the Customer Contact Log. Mailware will use the

Mailing customer the type will change to Ordering).

Inquiry : Customers who respond to your mailing or ad, but
do not place an order (e.g., They may request more
information, or respond to an ad for a free sample).

Ordering : Customers who are placing an order with you 
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EXPORT

You can export any of Mailware's data for other programs to
use. These programs typically require data to be in a certain
format, and each field of a certain length and type. You can
Mailware's pre-built reports or create your own with the
included report writer then export the report data in any of
the following formats:

Paradox Database Table (*.DB)
dBase Database Table (*.DBF)
Fixed Field ASCII File (*.TXT)
ASCII Delimited File (*.TXT) - The default Field Separator is Mailware can import data from other programs, or other
a comma (,). The Text Delimiter is a double quote ("), and information that is sent to you. This means you can rent lists
the first row of the file contains the Field Names. on disk and load them into Mailware, have a third party take

The Paradox and dBase formats save the records of the data from software you no longer wish to use to run your
report without any formatting. They are the preferred export business, or continue using software you like for a specific
format when you have a choice in the program you are task, and then move the data into Mailware.
importing to. The fixed field text file is useful for viewing
records as plain text. The delimited ASCII format is useful Import is a very powerful feature that greatly enhances the
with mail-merge programs, and is accepted by almost all versatility of Mailware. Because of the way data inter-relates,
programs that support importing. importing can be complex. Mailware's Import Wizard makes

Mailware includes several pre-built Export Reports for when importing. It is best to test with a small file first. Then,
specific applications (including credit card processing verify all the data loaded into the proper fields (e.g., It is
software). These reports are available from the possible to mismatch fields and import a company name, for
Management>System section of the Report Explorer. example, into the customer First Name field).

HOUSE LIST

Every customer you add to Mailware becomes part of your
House List. The more information you collect about these

customers, the more valuable your House List becomes to
you, and to others who wish to rent your list from you.

Customers from lists you rent are not part of your House List
until they respond to one of your ads. When they do
respond, you can input a source key for each customer.
Mailware will automatically add those customers to your
House List.

IMPORT

your orders and send them to you on a daily basis, import

the process easy. However, you should exercise caution

The most important step in ensuring a good transfer of data
is proper preparation of the file you are importing. Be sure all
fields are complete, and if necessary, add fields that you
wish to have Mailware enter (e.g., If your customer import
file does not contain an Original Source Key, add it to the



Reference - Definitions Reference - Definitions

Mailware Reference Guide Mailware Reference Guide2.9 2.10

import file before importing, or manually update each Cash, check and credit payments are supported including
customer after). partial payments, and Mailware calculates sales tax,

OPERATOR ID

An Operator ID may be assigned to each Mailware
Professional in your company. Mailware uses this numerical
ID to track your employees' correspondence. and
transactions with customers. When they take an order, or
update the Customer Contact Log their ID is associated with
the transaction. 

Using the Operator ID you can track the number and amount
of orders taken by each employee, see which employees
corresponded with customers, and assign tasks to
employees using the Customer Contact Log, and its tickler
report

ORDERS

Mailware's order entry system is optimized for mail order
companies. Because it is integrated with the rest of
Mailware's modules it offers full tracking of Advertising
Source Keys, so you know which ads are working. It
remembers your customers, and their previous order
information. Or, you can add new customers at the same
time you take their order.

You also have easy access to your inventory including the
ability to lookup products using plain English. Plus, you can
add or edit products while the order is open, so you can take
your customer's order now. 

discounts and shipping for you. Also supported is export of
your credit card transactions for batch transmittal to your
merchant services provider. And, you can import or export
order data so a third party can take orders for you using
Mailware, their own software, or a special version of
Mailware we provide to qualifying services (like 800#
services).

You also have a full Zip Code database, the ability to add
reminder messages to the order form and each of your
products, and full edit capabilities after the sale, including
returning and canceling orders, or individual items.

Plus, we have made all this easy to use and even added
online tutorials just for your order entry professionals, so
they don't have to learn the whole program.

ORIGINAL SOURCE KEYS

Each time a customer responds to one of your
advertisements, you can track the Advertising Source Key
associated with the ad. The first time a customer contacts
you, and you add the customer to your database that key
automatically becomes the Original Source Key. This first
key is important because it is used to measure which ads
bring you the type of customers you want 

For example, Ad #1 may bring you many responses for a
free sample, but those customers may never buy, or only
buy once. Ad #2 may bring fewer customers, but those
customers may make larger purchases, or buy repeatedly
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from you. Without an Original Source Key you would be
unable to determine which ads are profitable in the long run.

In addition to the Original Source Key, subsequent source
keys may be added to the customer's history each time they
contact you. Subsequent keys are usually added when a
customer places an order, or when you update the
Customer Contact Log. These additional source keys help
you determine which catalogs, direct mail pieces or other
ads are profitable with your existing customer base. A
source key may be an Original Source Key for one
customer, and a subsequent source key for another.

As you can guess, tracking keys manually becomes a
tedious, and nearly impossible job. Because Mailware
calculates this information for you, source keys are much
more useful than a simple tabulation of responses. All you
need to do is record the source key when the customer
contacts you. This may be as simple as asking them where
they saw your ad, or printing actual codes on your return
mail pieces. To see how your ads are doing, individually or
as part of a group, use Mailware's Project module.

Original and subsequent source keys associated with a
customer are visible when you view a customer's history.

PRINT VENDORS

Second only to the cost of advertising, your printing costs
are a major expense for your mail order company. Mailware
provides tracking of the vendors who provide these services,
and detailed tracking of their costs. This is also a handy tool
for comparing prices from different vendors.

PRODUCT VENDORS

Whether you make your own products, purchase them from
others, or have them drop shipped, Mailware keeps your
vendor database organized - even if you do a little of each. It
provides contact information for each of your vendors, and
associates their products with them. You can also create
purchase orders when it's time to reorder, and update costs
and quantities when you receive inventory.

PRODUCTS

Your inventory may be stored on site, drop shipped or made
to order. Mailware provides full tracking of your products,
and their suppliers. It keeps track of quantities on hand and
back ordered, and reminds you when to reorder, and when
to expect shipment. Plus, you can create purchase orders to
send to your vendors. Mailware remembers how much you
paid for each item, and calculates your average cost of
goods. And, it knows how much each item weighs, its
shipping costs to you, and to your customers and its retail
price.

Finding products is easy, and you can associate reminder
messages with each product so you don't miss opportunities
when you take orders. You can even use bar codes on your
products and read them directly into Mailware when you add
a product, or receive inventory.
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PROFIT PURCHASE ORDER

Mailware calculates your profitability by tracking the You can create a purchase order within Mailware to reorder
expenses and revenues associated with advertising source products from any of your Product Supply Vendors.
keys. You can view the profitability of ads with reports, or by Mailware will track the purchase order number, and assist
grouping them into Projects. you with adjusting prices and quantities when you receive

Mailware depends on your source keys to track your profits.
It is important to record any costs you wish tracked in the
source key costs field when you add or edit a key. It is
equally important to track source keys for all orders. This
generates your revenue and expense information. In
addition, Mailware includes expenses recorded elsewhere in
your database (e.g., Inventory costs).

PUBLICATIONS

A publication may be a magazine, a newspaper, a card deck Reports fall into one of 3 categories:
or even a tv station. Storing publication information in
Mailware serves two primary purposes. Management Reports  Informational reports about the

It enables you to store contact information related to the lists only your customers who have requested free
publication. These contacts may be the publication itself, or information based on the Inquiry type field entered when you
an advertising firm that handles your account. add a customer).

When you create advertising source keys you are given the Operation Reports  Reports you use to complete a task. For
option of assigning the publication to each key. That way example, the Pick List report lists the names and quantities
when a customer places an order you can use the source of products you need to pull to fill that day's orders. Other
key to determine where your ad was seen. Mailware also Operation Reports include purchase orders, invoices and
uses the information to measure the effectiveness of your other reports you use to complete tasks or that prompt you
ads. to take action (e.g., The Tickler report lists all outstanding

inventory.

REPORTS

Mailware comes with several built in reports you can print, or
edit with the included Report Writer. Reports can be
selected from the Report Explorer. For more information
about reports see How to Print Reports (p. ?.?) and Using
the Report Writer (p. 4.1).

status of your company (e.g., the Inquiry Customer Report

tasks in your Customer Contact Log).
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Labels  Labels can be simple blank labels with your return
address, or created from your database for specific
recipients (e.g., Shipping labels for that day's orders).
SALES TAX TABLE

You can create a list of all agencies to whom you remit sales
tax, and the tax rate. Click the ... button that appears in the
Location field to open the Tax Code Creation dialog. In it you
can specify a tax rate to be applied based on the customer’s You can set up any number of shipping companies (like the
country, state or Zip code.. You can also specify for each Post Office, FedEx, UPS, etc.), and the services they offer
district whether sales tax is collected on shipping. (e.g., Priority Mail, Overnight, 2nd day, etc.).

When you take an order the Sales Tax Table is
automatically calculated based on the Shipping Address and
the Sales Tax Codes you create.

SHIPPING VENDORS

SYSTEM FLAGS

Mailware provides the ability to assign flags that mark the
status of an account. You can use these to mark a
customer's account as inactive, for example. When a flag is
checked the database contains the value TRUE to indicate
the flag is on.

In this way you can include or exclude accounts of certain
types when creating a report. For example, you could create
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a list of inactive accounts, and mail them a welcome back make all necessary associations (like which orders go with
offer.  which customers) so it can track your company's

Following are examples of system flags:

Bad Credit:  If a customer is past due in payments to you, or
sent a bad check select the Bad Credit flag. This allows you
to avoid extending credit, or accepting a non-cash order
from this customer. You can also use it to generate a
collection letter.

Don't Send Mail:  If a customer does not wish to receive
promotional material from you or a third party select the
Don't Send Mail flag.

Inactive Account : Use this flag if you have not received an
order from this customer recently (a recommended time
frame is 6 months).

TABLES

Everything you enter into Mailware is stored in a database.
For example, when you enter your customers they become
part of the customer.db file which contains each customer's
name, address and other information. This database file is
also called a Table.

Mailware makes Tables easy to read by showing you your
information in forms or lists. For example, each customer’s
name and address is displayed on the Customer form.

Tables are accessible through the Company Database. You
can use them to enter, and view information. Mailware will

performance.

TICKLE DATE

A tickle date is used to remind you to do something. When
you assign it to a task, that task appears on a tickler report
on its tickle date. For example, if you want to mail a letter to
a customer on January 15, 1999, you enter a tickle date of
1/15/99. You then associate the tickle date with the task -
mail letter. When the tickler report is printed on January 15,
1999 it contains this particular task. And, you mail your
customer a letter.

In Mailware this is done in the Customer Contact Log. The
Tickle Date is a handy tool for customer service, and for
other routine tasks like mailing collection notices, filling book
club type orders, sending catalogs etc. It is designed to be
flexible to meet as many needs as possible, so feel free to
use your imagination.
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ADD A CATALOG

On the Company Database form click the Ads  button, then
click the Tables  tab. Select Catalogs  from the list, and click
the Add To  button.

Field Definitions:

Catalog
Description : You can type anything you like here, however,
you may wish to enter text that can be used to help you
identify which version of the catalog this is when you add a
source key for it.

Cost : Include all costs to produce the catalog. Do not
include mailing costs. They can be associated with the
Advertising Source Keys for this catalog.

Effective  Date: This is the date the offers in the ad begin
(not the mail date for the catalog).

Expire  Date: This is the date on which the offers in the ad
are last available to your customers.

Source Keys
These are the Advertising Source Keys associated with this
catalog.
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ADD A CUSTOMER

On the Company Database form click the Cust button, then
click the Tables tab. Select Customers from the list, and
click the Add To button.

Shortcut : Click the Add Customer icon  on the toolbar.

Field Definitions:

Additional Info
Notes : You can type anything you like here. Mailware can
query on this field when you are creating Custom Reports or
Selects. Therefore, you may wish to enter information you
can use to associate this customer with a specific group. For
example, you could enter the customer's age as AGE=45.

Tip: The following 3 fields are automatically
updated by Mailware when you add a
customer or enter a contact in the Contact Log.
When adding a new customer you can click
the New Contact button to open the log, then
enter the Source Key and Action. The first time
you enter a source key for a customer, that key
becomes the customer's Original Source Key.
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The following 3 fields may be changed Order button.

manually by clicking the lock icon  to make
them editable. The fields will remain open for
each successive customer you add, or until
you close the Customer form.

Customer  #: Mailware automatically assigns an internal
number to each customer you add. It is visible in the System
ID# field on this screen. If you want to use an Alternate
Customer Number, enter it in this field, or set up an
Alternate Customer Number Formula to have Mailware enter
it for you.

Customer  Type : When you add a customer Mailware
defaults this field to Inquiry. The Customer Type is
automatically updated by Mailware whenever the customer's
status changes (e.g., when you take an order the type is
changed to Ordering).

Original  Key : This is the Advertising Source Key associated
with the first contact with this customer. You should add this
key by clicking the New Contact button, and adding an entry
in the Customer Contact Log. Additional source keys can be
added each time a customer responds to one of your ads,
mailings or catalogs. You can assign keys to customers
when taking an order, or in the Customer Contact Log.
(Note: You should never change the Original Source Key
unless it was entered incorrectly.)

System Flags : These flags can be used by the Selects
when creating lists, and when creating Custom Reports.

Tip: You can take an order for a customer you just
added by pressing Alt-O or clicking the New

Orders
You can view all the orders for each customer here. You can
also add a new order, or select an existing order and edit it
with the add and edit buttons on the bottom of the form.

Contacts
Each time you correspond with a customer you can add your
contact information here. See the Customer Contact Log for
more details.
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ADD A PRINT VENDOR ADD A PRODUCT

On the Company Database form click the Ads button, then On the Company Database form click the Inven button, then
click the Tables tab. Select Print Vendors from the list, and click the Tables tab. Select Products from the list, and click
click the Add To button. the Add To button.

Field Definitions:

Pricing
Description : Type the name of the product your print
vendor supplies (for example, Brochure). Then you can
enter prices for various services your vendor provides. This
is handy for comparing vendors, or tracking your costs.

Shortcut:  You can open the Product form with the Inventory

icon  then click the Add button.

Field Definitions:

Product
Product  #: You may enter a number, text or both here. This
field is automatically capitalized so you can easily find the
product later. You can also wand a bar code into this field.
The Product # can accommodate up to 15 characters.
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Tip: If more than one vendor supplies you with the shows on the Order Entry screen.
same product, enter the product twice, but with
different product numbers. Ship Cost:  This is the cost to you to ship this individual item.

Description : Enter up to 30 characters to help you identify Ship Extra Charge:  If this product requires an additional
this product when viewing your inventory. shipping charge to the customer (for example, oversized

Supplier : You can select a Product Supply Vendor here to product, the extra shipping charge will be added to the total
associate the product with its supplier. If you have not added sale.
the supplier yet, you can make the association later by
editing the product. Drop Ship Item:  If you do not stock this item, but have a

Tip : If a vendor provides you with several products,
enter the vendor first then, while in the Product
Supply Vendor form, click the Products tab
then the Add button. Each product you add will
be associated with that vendor.

Cost : Each time you receive inventory you may pay a
different amount. Mailware calculates your average cost of
goods by recording how much you paid for each shipment.
For example, if you paid $10 each for your first shipment of
100 items, $11 each for your second shipment of 75 items,
and $12 each for a third shipment of 50 items your average
cost for all your items would be $10.78 each. This cost
method is most effective if you use First in First Out (FIFO)
for your inventory. Or, in other words - you sell items in the
order you receive them.

Order Message:  This 50 character message will be
displayed when the product is selected during an order. It is
a convenient way to add reminders to products (for example:
"This item requires batteries."). Note: This message may be
used effectively with the Message for new order which

items), enter the amount here. When a customer orders this

third party ship it to your customer, check this box.

Stock Levels
Reorder at:  You can specify the quantity this item may
reach before Mailware reminds you to order more.
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Reorder Qty:  The number of items to order when the
Reorder at threshold is met.

Reorder Price: The amount you expect to pay for each
item. This amount is for reference only since actual costs
may vary. You will have the opportunity to enter the actual
price when you receive inventory.

ADD A PRODUCT SUPPLY VENDOR

On the Company Database form click the Inven button, then
click the Tables tab. Select Product Supply Vendors from
the list, and click the Add To button.

Shortcut: You can open the Product Supply Vendor form

with the Vendors icon  then click the Add button.

Field  Definitions :

Vendor Information
Enter each vendor, and contact information. If you make all
your own products, enter your company information here.

Products
These are the products associated with this vendor. If you
wish to add a product,, or edit a product you will be taken to
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the Products form.

Tip: If more than one vendor supplies you with the
same product, enter the product twice in the
Products form, but with different product
numbers.

Tip: If a vendor provides you with several products,
enter the vendor first then while in the Product
Supply Vendor form, click the Products tab
then the Add button. Each product you add will
be associated with that vendor.

Purchase Order
This tab lists all the purchase orders you have created for
this vendor. You can view or edit any purchase order by
double clicking it, or clicking the Edit button. From this
screen you can also create a new purchase order.

Shortcut : You can create a new purchase order from any
tab on the Product Supply Vendor screen. Simply click the
New PO button.

ADD A PUBLICATION

On the Company Database form click the Ads button, then
click the Tables tab. Select Publications from the list, and
click the Add To button.

Field  Definitions :

Title : A publication may be anything from a magazine to a tv
station. The title you enter will be the publication name used
when you add a source key.

Media : Trade refers to a publication for a specific industry
(e.g., Direct is a trade newspaper for the mail order
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industry). Card Decks are 3x5 cards mailed in packs of
about 100 other cards.

Circulation : The number of items sent to subscribers or
recipients.

ADD A SHIPPING VENDOR

On the Company Database form click the Sys button, then
click the Tables tab. Select Shipping Companies from the
list, and click the Add to button. 

Type the name of the shipping company (up to 10
characters) in the Shipper column, and enter the type of
service (up to 30 characters) in the Description column (e.g.,
enter USPS as the Shipper, and Post Office 3day Priority
Mail as the description). Click the ... button in the Charges
column to set up shipping charges as described below.

To add additional items click the Add button  on the

toolbar. To cancel a change click the Cancel button . All
additions and changes are saved when you exit the form, or

you can click the Post button  on the toolbar.
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Shipping charges: Charges by Order Total  

Flat Charges

Flat charges are cumulative (i.e., they are added together on addition to Flat Charges and Weight Charges you specify for
an order), and can be used in conjunction with order total each shipping method. You can also use the By Order Total
and weight calculations. For example, you can enter a Per to create charges above a specified order amount. For
Order charge of $4.00, a Per Pound charge of $1.00 and a example, enter a From of $200.01 and a Charge of $50 (no
By Order Total calculation (as in the screen below where an To is needed) and only orders above $200 will be charged
order under $10 is charged $3.00). In a $9 order weighing $50.
10 pounds the charge will be calculated as $4.00 + $10.00 +
$3.00 = $17.00.

Charges by Order Total are calculated based on the
Subtotal of items (excluding Sales Tax) and are charged in
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Charges by Weight

 

Charges by Weight are calculated based on the combined
weight of items added to the order. You can enter each
item's weight in the Product screen Weight field. Charges by
Weight are added to Flat and Order Total charges you
specify. As in the by Order Total method, you can create
charges that are applied only when an order exceeds a
value you specify. For example, enter a From of 100.01
pounds and a Charge of $75 (no To is needed) and only
orders weighing more than 100 pounds will be charged $75.

ADD A SOURCE KEY

On the Company Database form click the Ads button, then
click the Tables tab. Select Advertising Source Keys from
the list, and click the Add To button.

Field Definitions:

Source Key : Enter the code, you have assigned for a
particular ad, mailing or catalog. This is your Advertising
Source Key. 

Description:  Enter any text you wish in the next field.
Starting the description with the publication date of an ad is
a handy reference (e.g., 1/97).

Type: This refers to the type of ad (e.g., display or classified
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ad in a magazine, a direct mailing etc.)

Catalog:  Use this type to activate the Catalog drop box
below this field where you can associate a Catalog with this
source key.

Classified:  Classified ads are typically either One Shot or
Two Step ads: One Shot ads ask for the order. These are
effective only for very low priced items. Two Step ads offer a
free or inexpensive sample or demo. The sample is mailed
with sales literature that asks for the order.

Display:  These are usually large ads ranging from 1/8 of a
page to a multiple page spread that appear in a publication.
Because display ads are expensive, and offer you room to
describe your product they typically ask for the order, and
offer higher priced items.

Direct:  Direct Mail usually consists of several pieces mailed
directly to a potential customer. The components of a direct
mail package may include: a sales letter, an order form, a
publisher's note and a brochure. By assigning a source key
to the entire package Mailware can track the effectiveness of
a direct mail campaign. You can also assign different source
keys to different parts of a direct mail campaign.

For example, you could create 2 different direct mail
packages, and assign each a different source code. Or, you
could send the same package to 2 different lists, each with
its own source code. By combining both of these methods
you can create several distinct groups all within the same
mailing. This is a very effective method for testing.
Internet:  Use this type for Internet ads and search engines.

Other:  Use this for an ad that does not fit one of the
available categories.

Publication:  Select a Publication, if applicable, from the
drop down list, or add a publication and return here to select
it.

Catalogs:  Source Keys may be assigned to a catalog once,
or you may assign several to the same catalog. This allows
you to measure the effectiveness of the same catalog sent
to different customers, or at different times.. Enter the
appropriate catalog here from the drop down list, or add a
catalog, and return here to select it.

Date:  Enter the date you actually placed the ad (not its
publish date), or mailed a campaign.

Renew Date:  If you plan to advertise in this publication
again enter the deadline for submitting a new ad in the
Renew Date field.

Mailings:  Enter the number of pieces you mailed, or the
circulation for the publication in the Mailings field.

Advertised Products:  You can associate up to three
different products with this ad by selecting them from the
drop boxes in the Products fields. If you have multiple items
you can set up a catalog, and refer to it in the catalog field
above.

Ad Price:  This is the actual price for a classified, display or
other paid ad. Do not include printing, postage or mailing
costs which are provided for below.
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Printing: Enter any printing costs associated with this ad.

Postage:  For mailings you can separately record the total
cost of postage here.

Mailing: Any additional costs to mail can be separately
recorded in the Mailing field.

Tip: Create source keys that have meanings to you.
For example, DM197 for a direct mail piece
you sent in January 1997.

ADD AN ORDER

Tip: Click the Find Customer icon  on the toolbar, or
press the F4 key, instead of the Add Order icon. If the
customer is not found you can use the Add Customer
button on the search screen to enter the customer
then click the New Order button.

On the Company Database form click the Order button, then
click the Tables tab. Select Orders from the list, and click the
Add To button.

Shortcut:  Click the Add Order icon  on the toolbar.

Whichever method you choose to take an order, your first
step will be to find the customer. If you open an order

directly, click the  button in the Cust System ID  field to
start the search.
 

The following Customer Search screen will open so you can
find the customer in your database.
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The Customer Search screen will open on top of the order screen. You
can then search for the customer for whom you are taking an order.
When you click the OK button the customer’s information will be entered
on the order form.

If the customer is not found you can click the Add Customer
button (if available) on the form. After you enter the
customer click the New Order  button on the Customer
screen to enter the order.

Note: The Add Customer  button is not available on the
Customer Search dialog when it is opened from a
blank order. To add a customer when the button is
unavailable, Cancel  the search. Press the F5 key,
and select Customers  from the Tables tab. Then
click the Add To  button. After adding the customer,
click the New Order  button on the Customer screen.

Field Definitions:

Cust System ID : This is the number assigned to a customer
when you add them to Mailware. If you click in this field a 
button will appear which you can click to search for the
customer. If you find the customer their information will
appear on the order form when you close the search dialog.
If the customer is not found you can add the customer using
the instructions above, then complete the order.

Operator  ID: Selecting your Operator ID from the drop down
list will indicate that you took this order.

Source  Key : This is the ad source key for this order. The
customer may be able to read it from their catalog, ad or
other sales material.

Order  #: This number is assigned automatically by the
system, and prints out on labels and reports.
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Products

Order  Date: This will automatically default to today's date. each = $20, or if you enter a discount of 10% this amount
You may change it if you wish, but doing so will exclude the will equal $18).
order from any reports that run based on Order Date=Today.

Shipping  Address : Enter an address here if it is different the Items button.
than the customer's billing address.

Products : Item Detail Tab
Clicking in the Products field activates a ... button you can
use to Search for Products to enter for this order. Then the Description : A description of the currently selected product
following information can be added or edited for each item. is displayed here. This description can be changed on the

Qty  This is the number of products the customer is ordering.

Disc  You can input a percentage discount here (e.g., 10%) Product form when this item was added to inventory.
that will be calculated by Mailware, and deducted from the
sale price. Customize:  This button opens a form in which you can

Price  This is the price for this product as entered on the This information can be included in reports (e.g., invoices,
Products form. You can enter a different price directly on the work orders etc.). 
order form if desired. 

Ship  When you fill the order this amount may be changed to Customize is selected during the order the form will contain
show the item has been shipped.. To update this field click the information you entered.
the Mark Shipped  button, and change the quantity to show
the number sent. This field is automatically updated when
you fill orders with the Process Open Orders action. Shipping Tab

ST This field shows the status of the item (SH = Shipped,
CM = Committed, BO = Backordered, CA = Canceled, RT =
Returned).

Ext Price  Mailware calculates the extended price for this
product including quantity and discounts (e.g., 2 items at $10

Note:  To make changes to the currently selected item click

Product form.

Message : This is the Order Message you entered on the

enter details about the selected product (size, color etc.).

You can specify information to collect for each product by
using the Customize button on the Product table. When
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Ship  Via: Select a shipper and method from the drop box
here. Additional shippers and their services may be added in Subtotal : Mailware calculates the subtotal of the order
the Shipping Vendor table. including any discounts.

Description : This is the description for the Ship Via field Tax: A tax amount will be automatically entered here based on
that you enter when you add a Shipping Vendor. the Sales Tax Codes you create in the Sales Tax Table.

Tax on Shipping:  Indicates whether shipping costs are Shipping : A shipping charge will be entered automatically here
included in the sales tax calculation for the order. You can based on the charges you enter in the Shipping Companies
specify whether tax is collected on shipping for each district Table.
in the Sales Tax Table.

Payment Tab

Method:  The type you choose will determine which fields are type an Approval # in the Payment tab.
available below it.

Action:  Choose Sale or Credit to enter a charge or a return. when you process your open orders.

Number : Enter the appropriate number here for the pay Print  Label : If you check this box you can print a shipping
method type (credit card number, PO number etc.) label when you process your open orders.

Exp : Enter the expiration date of the credit card here. Tip: When you are testing you will often offer the same

Approval  #: Enter the card or check approval number here. If a discount (which will show on your customer's invoice),
you batch process card approvals, you can edit the order to or you can add multiple, identical products to your
enter this information, or do so when you process open orders. inventory with different prices.

Note:  An approval # must be entered to have an amount paid Tip: To print an invoice immediately click the Reports button
entered. Use an actual approval number or anything you wish and choose Print Invoice from the top of the list.
(an X, the date, the initials of the operator etc.)

Order Totals

Total : Mailware calculates the total order for you here. Use this
amount in the Paid field if the customer pays the full amount.

Paid : The Paid amount is entered for you when you receive or

Print  Invoice : If you check this box you can print an invoice

product at different prices. You can either show this as
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ASSIGN A CUSTOMER NUMBER

On the Company Database form click the Cust button, then
click the Tables tab. Select Customers from the list, and click
the Open button, then click the Additional Info tab. 

Click the lock icon  to make the field editable (it will turn
white). You may then simply type the new customer number
into the Customer # field. The number may contain
alphabetical characters, and may be up to 12 characters long.
Note: the System ID# assigned by Mailware cannot be
changed. This ensures you always have a unique number for
every customer, even if the Alternate Number is duplicated.

Tip: You do not have to assign numbers manually. You can
create an Alternate Customer Number Formula instead
to have Mailware enter it for you each time you add a
customer. See Create an Alternate Customer Number
Formula (p. 3.68).

Field Definitions:

Additional Info
Customer #:  Mailware automatically assigns an internal
number to each customer you add. It is visible in the System
ID# field on this screen. If you want to use an Alternate
Customer Number, enter it in this field,.or set up an Alternate
Customer Number Formula to have Mailware enter it for you.
This number may be up to 12 characters long.

System ID:  This is the sequential number assigned by
Mailware. To ensure your data's integrity, this number cannot
be changed. 

Note : This number is incremented every time you add a
customer, even if you cancel or delete the record.
Therefore, you may notice gaps in the sequence (for
example, you may have a customer with a system
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number of 100, and the next customer with 103). This
does not mean you have any lost or hidden records.

ASSIGN AN OPERATOR ID

On the Company Database form click the Sys button, then
click the Tables tab. Select Mailware Professionals from the
list, and click the Add to button.

Or,

To edit an existing Operator ID click the Open button. You can
then scroll through all your Operators using the navigator
buttons  on the toolbar, then simply type the new

information, or click the Edit button  on the toolbar. 

Note: you should edit for corrections only. If you wish to add a
new Operator you should assign a new ID to prevent confusion
(i.e., changing an Operator's name for the same ID# will result
in all transactions related to that ID# being associated with only
the new Operator.)

To delete an Operator ID, click the Delete button on the
toolbar. You will be asked for confirmation. 

Note: deleting an Operator ID frees its number for reuse. If an
employee is no longer using Mailware, or has left your
company you should retire their number by entering a
Deactivate Date.
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Field Definitions:

Operator ID:  You may type a long number here, but a
maximum of 5 characters is recommended so that you will see
the whole number on other screens and reports. Leading zeros
will be removed (e.g., 00001 will become 1), and this is a
numerical field (numbers only - no alphabetical characters). 

Deactivate Date:  You can specify the date an Operator ID
expires. This can be used for temporary employees, and
training purposes. It is especially useful, however, for retiring
numbers when employees leave, or stop using Mailware.

CANCEL AN ORDER

If you are not already viewing the order you wish to cancel go
to the Company Database form click the Order button, then
click the Tables tab. Select Orders from the list, and click the
Open button.

You can then scroll through all your orders using the navigator
buttons  on the toolbar, or search for a order with the

Find icon 

Tip: You can use the Find Order icon   to quickly locate
the order. Or, open the Customer screen for the
appropriate customer, and double click the order you
wish in the Orders tab.
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Once you have located the order you may cancel all or part of
it. First, select the first product you wish to cancel (by clicking
on it in the grid on the Order form). Then, click the Item button
and select Cancel..

In the dialog that appears type the number of items you wish
to cancel. The quantity you enter will appear in the Canc field
on the grid when you save the order. To update the form

without closing it click the post icon  on the toolbar.

Repeat this process for all items you wish to cancel, then click
the Save button to close the form. Or, click the Order button to
cancel all items in the order.

CHANGE A CUSTOMER NUMBER

You cannot change the System ID that Mailware assigns to a
customer. This ensures the integrity of your data. However,
you may assign or change an Alternate Customer Number as
follows:

On the Company Database form click the Cust button, then
click the Tables tab. Select Customers from the list, and click
the Open button. You can then scroll through all your
customers using the navigator buttons  on the

toolbar, or search for a customer with the Find icon .

Shortcut: You can use the Find Customer icon  to quickly
locate the customer.

When you find the customer for whom you wish to change the
Customer Number, click the Additional Info  tab. Then, click

the lock icon  to make the field editable (it will turn white).
You may then simply type the new customer number into the
Customer # field. The number may contain alphabetical
characters, and may be up to 12 characters long. 

Tip: You do not have to assign numbers manually. You can
create an Alternate Customer Number Formula instead
to have Mailware enter it for you each time you add a
customer. See Create an Alternate Customer Number
Formula (p. 3.68).

Note: the System ID# assigned by Mailware cannot be
changed. This ensures you always have a unique
number for every customer, even if the Alternate
Number is duplicated.
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Field  Definitions :

Additional Info
Customer #:  Mailware automatically assigns an internal
number to each customer you add. It is visible in the System
ID# field on this screen. If you want to use an Alternate
Customer Number, enter it in this field,.or set up an Alternate
Customer Number Formula to have Mailware enter it for you.
This number may be up to 12 characters long.

CHANGE A CUSTOMER TYPE

On the Company Database form click the Cust button, then
click the Tables tab. Select Customers from the list, and click
the Open button, then click the Additional Info tab. 

Click the lock icon  to make the field editable (it will turn
white). You may then simply select the new customer type
from the drop list in the Customer Type field. NOTE: You do
not need to manually edit this field unless you wish to change
the type that is automatically entered by Mailware. The default
type when adding customers is Inquiry, and when taking orders
is Ordering.

Field  Definitions :
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Additional Info
Customer Type: When you add a customer Mailware defaults
this field to Inquiry. The Customer Type is automatically
updated by Mailware whenever the customer's status changes
(e.g., when you take an order the type is changed to Ordering).

CHANGE MY COMPANY INFORMATION

From the text menu at the top of the Mailware screen click on
Tools then select Preferences. Click the Company Info tab.

You can then simply type your new information over the old.
Your information will be saved when you click the OK button,
or press the Enter key.
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CREATE A PURCHASE ORDER

On the Company Database form click the Inven button, then
click the Tables tab. Select Purchase Orders from the list, and
click the Add To button.

Or,

To edit an existing Purchase Order click the Open button. You
can then scroll through all your Purchase Orders using the
navigator buttons  on the toolbar, then simply type

the new information, or click the Edit button  on the toolbar.

To delete a Purchase Order, click the Delete button  on the
toolbar. You will be asked for confirmation. 

Shortcut: You can open the Purchase Order form with the

Order Product icon 
Field  Definitions :

Vendor:  Select a Product Supply Vendor from the pull down
list.

P.O. Number: You may enter up to 30 characters in this field,
or use the sequential number provided by Mailware.

Rcvd : The received quantity will be completed when you
receive inventory.

Message : The text you type here will print on the purchase
order.

Paid : The paid amount will be completed when you receive
inventory. You can also enter the amount manually by typing
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it here.

Products : Click this field to activate a drop down list of
available Products. If you select Vendor, only products
associated with the Product Supply Vendor you selected in the
Vendor field will be shown. All allows you to see, and select all
your products even though they may not be available from the
selected vendor.

Print P.O.  If this check box is selected you can print the
Purchase Order later. Purchase Orders may also be selected
for printing based on their date.

CREATE A SALES TAX TABLE

On the Company Database form click the Sys button, then
click the Tables tab. Select Sales Tax Tables from the list, and
click the Add to button. Type the name of the agency to whom
you are remitting sales tax in the Location column then click
the ... button to open the Tax Code Creation dialog.
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In the Tax Code Creation dialog you can specify a rate that will
be automatically applied on orders based on the Shipping
Address. You need only select a Country, but can narrow the
selection by select a State (or Province) and Zip Code (or
Postal Code).

For example, to have orders automatically apply a 6% rate on
Florida addresses select a Country of United States and a
State of Florida (leave the Zip Code blank). Then enter a 6 in
the Tax % field. You can also check the Tax On Shipping box
to have shipping charges included in the sales tax calculation,
and specify a Report Code you can use to identify this rate in
reports you create.

Note: When you save a Tax Code the Sales Tax table will
change to reflect the new code in the format: Country Code;
State Code; Zip Code; Report Code. In the example above the
Location would show: 240;FL;;FL.

To add additional items click the Add button  on the toolbar.

To cancel a change click the Cancel button . All additions
and changes are saved when you exit the form, or you can

click the Post button  on the toolbar.

CREATE A ZIP CODE TABLE

Mailware comes with a complete Zip Code database. You can
access it at any time to make changes or corrections.

On the Company Database form click the Sys button, then
click the Tables tab. Select Zip Code Tables from the list, and
click the Open button. 

To change Zip Code information simply type the new data over

the old, or click the Edit button  on the toolbar. To add

additional items click the Add button  on the toolbar. To
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cancel a change click the Cancel button . All additions and
changes are saved when you exit the form, or you can click the

Post button  on the toolbar.

CREATE AN ALTERNATE CUSTOMER NUMBER FORMULA

From the text menu at the top of the Mailware screen click on
Tools then select Preferences. Choose the Customers tab.

Field  Definitions :

Customers
You can create your own formula to have Mailware
automatically assign a customer number from elements of the
customer's name, address etc. (For example, a customer
number could be composed of the first 3 letters of a customer's
last name followed by the zip code.)
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Field  Name: Pick each of the fields you want to use to create
the customer number. You may use just 1 field, or up to all 5. Tip: Changes to the formula will only affect customers
Note: the Type In Value field allows you to enter any text you entered after the change.
wish to be part of the formula.

Start  At : Tell Mailware which character to use first. The first
letter is number 1, the second is 2, etc.

Go For : Then tell Mailware at which character to stop.

Replace  blanks...  If Mailware finds a blank, you can specify a
character to use in its place (e.g., an * ).

For example: If you set up the formula as follows:
Last Name 1 6
First Name 1 3
Zip 1 5

Replace blanks with this character *

And, you entered the following customer into Mailware:

 John Smith
 987 Elm Street
 City, St. 12345

The customer number for Mr. Smith would be:
SMITH*JOH123. (Note: the Alternate Customer Number is
limited to 12 characters, so only the first 12 characters you
define are assigned. In this case the Alternate Customer
Number stopped at the third digit of the zip code. Notice too
that since the last name was only 5 characters in length the
sixth character was considered a blank, and was replaced with
an *.)



Reference - Instructions Reference - Instructions

Mailware Reference Guide Mailware Reference Guide3.71 3.72

DELETE A CATALOG

On the Company Database form click the Ads button, then
click the Tables tab. Select Catalogs from the list, and click the
Open button. 

You can then scroll through all your catalogs using the
navigator buttons  on the toolbar, or you may search

for a catalog by using the Find icon  on the toolbar.

After you have located the catalog you wish to delete, simply

click the Delete icon . You will be asked for
confirmation.

CAUTION: Once confirmed, deletion is permanent.

DELETE A CUSTOMER

On the Company Database form click the Cust button, then
click the Tables tab. Select Customers from the list, and click
the Open button. 

You can then scroll through all your customers using the
navigator buttons  on the toolbar. 

Tip: You can use the Find Customer icon  to quickly
locate the customer.

After you have located the customer you wish to delete, simply

click the Delete icon . You will be asked for confirmation.

CAUTION: Once confirmed, deletion is permanent.

Note: The System ID associated with the customer will be
retired and cannot be reused. This ensures your
database is always accurate.

DELETE A PRINT VENDOR

On the Company Database form click the Ads button, then
click the Tables tab. Select Print Vendors from the list, and
click the Open button. 

You can then scroll through all your vendors using the
navigator buttons  on the toolbar, or you may search

for a vendor by using the Find icon  on the toolbar.

After you have located the vendor you wish to delete, simply

click the Delete icon . You will be asked for confirmation.

CAUTION: Once confirmed, deletion is permanent.

DELETE A PRODUCT

On the Company Database form click the Inven button, then
click the Tables tab. Select Products from the list, and click the
Open button. 

Tip: You can open the Product form with the Inventory icon
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You can then scroll through all your products using the
navigator buttons  on the toolbar, or you may search

for a product by using the Find icon  on the toolbar.

After you have located the product you wish to delete, simply

click the Delete icon . You will be asked for confirmation.

CAUTION: Once confirmed, deletion is permanent.

DELETE A PRODUCT SUPPLY VENDOR

On the Company Database form click the Inven button, then
click the Tables tab. Select Product Supply Vendors from the
list, and click the Open button.

You can then scroll through all your vendors using the
navigator buttons  on the toolbar, or you may search

for a vendor by using the Find icon  on the toolbar.

After you have located the vendor you wish to delete, simply

click the Delete icon . You will be asked for confirmation.

CAUTION: Once confirmed, deletion is permanent.

DELETE A PUBLICATION

On the Company Database form click the Ads button, then
click the Tables tab. Select Publications from the list, and click

the Open button. 

You can then scroll through all your publications using the
navigator buttons  on the toolbar, or you may search

for a publication by using the Find icon  on the toolbar. After
you have located the publication you wish to delete, simply

click the Delete icon . You will be asked for confirmation.

CAUTION: Once confirmed, deletion is permanent.

DELETE A SHIPPING VENDOR

On the Company Database form click the Sys button, then
click the Tables tab. Select Shipping Companies from the list,
and click the Open button. 

You can then scroll through all your shipping vendors using
the navigator buttons  on the toolbar, or you may

search for a vendor by using the Find icon  on the
toolbar.

After you have located the vendor you wish to delete, simply

click the Delete icon . You will be asked for confirmation.

CAUTION: Once confirmed, deletion is permanent.
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DELETE A SOURCE KEY

On the Company Database form click the Ads button, then
click the Tables tab. Select Advertising Source Keys from
the list, and click the Open button. 

You can then scroll through all your source keys using the
navigator buttons  on the toolbar, or you may

search for a source key by using the Find icon  on the
toolbar.

After you have located the source key you wish to delete,

simply click the Delete icon . You will be asked for
confirmation.

CAUTION: Once confirmed, deletion is permanent.

DELETE AN ORDER

Tip: Rather than delete an order you may prefer to cancel
or refund part or all of the order instead. This
effectively deletes the order while maintaining a
record of it.

On the Company Database form click the Order button, then
click the Tables tab. Select Orders from the list, and click the
Open button. 

You can then scroll through all your orders using the
navigator buttons  on the toolbar, or you may

search for an order by using the Find icon  on the
toolbar.

Shortcut:  You can use the Find Order icon  to quickly
locate the order.

After you have located the order you wish to delete, simply

click the Delete icon . You will be asked for
confirmation.

CAUTION: Once confirmed, deletion is permanent. 

Note: You can delete individual products from an order by
selecting each one then pressing Ctrl and Del on your
keyboard. It may be necessary to delete items from an order
before the entire order can be deleted.
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EDIT A CATALOG

On the Company Database form click the Ads button, then
click the Tables tab. Select Catalogs from the list, and click
the Open button.
You can then scroll through all your catalogs using the
navigator buttons  on the toolbar, or search for a

catalog with the Find icon .

After you have located the catalog you wish to edit, you can
simply tab to or click on the fields you wish to change, and
enter the new information, or you can click the edit button

 on the toolbar.

Field Definitions:

Catalog
Description : You can type anything you like here, however,
you may wish to enter text that can be used to help you
identify which version of the catalog this is when you add a
source key for it.

Cost : Include all costs to produce the catalog. Do not
include mailing costs. They can be associated with the
Advertising Source Keys for this catalog.

Effective  Date: This is the date the offers in the ad begin
(not the mail date for the catalog).

Expire  Date: This is the date on which the offers in the ad
are last available to your customers.

Source Keys
These are the Advertising Source Keys associated with this
catalog.
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EDIT A CUSTOMER

On the Company Database form click the Cust button, then
click the Tables tab. Select Customers from the list, and
click the Open button. 

You can then scroll through all your customers using the
navigator buttons  on the toolbar, or search for a

customer with the Find icon .

Tip: You can use the Find Customer icon  to quickly
locate the customer.

After you have located the customer you wish to edit, you
can simply tab to or click on the fields you wish to change,
and enter the new information, or you can click the edit

button  on the toolbar.

Field  Definitions :

Additional Info
Notes : You can type anything you like here. Mailware can
query on this field when you are creating Custom Reports or
Selects. Therefore, you may wish to enter information you
can use to associate this customer with a specific group. For
example, you could enter the customer's age as AGE=45.

Tip: The following 3 fields are automatically updated by
Mailware when you add a customer, or enter a
contact in the Contact  Log . When adding a new
customer you can click the New Contact button to

open the log, then enter the Source Key and Action.
The first time you enter a source key for a customer,
that key becomes the customer's Original Source
Key. The following 3 fields may be changed manually

by clicking the lock icon  to make them editable.
The fields will remain open for each successive
customer you add, or until you close the Customer
form.

Customer  #: Mailware automatically assigns an internal
number to each customer you add. It is visible in the System
ID# field on this screen. If you want to use an Alternate
Customer Number, enter it in this field, or set up an
Alternate Customer Number Formula to have Mailware enter
it for you.

Customer  Type : When you add a customer Mailware
defaults this field to Inquiry. The Customer Type is
automatically updated by Mailware whenever the customer's
status changes (e.g., when you take an order the type is
changed to Ordering).

Original  Key : This is the Advertising Source Key associated
with the first contact with this customer. You should add this
key by clicking the New Contact button, and adding an entry
in the Customer Contact Log. Additional source keys can be
added each time a customer responds to one of your ads,
mailings or catalogs. You can assign keys to customers
when taking an order, or in the Customer Contact Log.
(Note: You should never change the Original Source Key
unless it was entered incorrectly.)

System Flags:  These flags can be used by the Selects.
when creating lists, and when creating Custom Reports.
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Tip: You can take an order for a customer you just edited
by pressing Alt-O or clicking the New Order button.

Orders
You can view all the orders for each customer here. You can
also add a new order, or select an existing order and edit it
with the add and edit buttons on the bottom of the form.

Contacts
Each time you correspond with a customer you can add your
contact information here. See the Customer Contact Log for
more details.

EDIT A PRINT VENDOR

On the Company Database form click the Ads button, then
click the Tables tab. Select Print Vendors from the list, and
click the Open button. You can then scroll through all your
vendors using the navigator buttons  on the

toolbar, or search for a vendor with the Find icon .

After you have located the vendor you wish to edit, you can
simply tab to or click on the fields you wish to change, and
enter the new information, or you can click the edit button

 on the toolbar.

Field  Definitions :

Pricing
Description : Type the name of the product your print
vendor supplies (for example, Brochure). Then you can
enter prices for various services your vendor provides. This
is handy for comparing vendors, or tracking your costs.
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EDIT A PRODUCT

On the Company Database form click the Inven button, then
click the Tables tab. Select Products from the list, and click
the Open button. 

Shortcut:  You can open the Product form with the Inventory

icon .

You can then scroll through all your products using the
navigator buttons  on the toolbar, or you may

search for a product by using the Find icon  on the
toolbar.

After you have located the product you wish to edit, you can
simply tab to or click on the fields you wish to change, and
enter the new information, or you can click the edit button

 on the toolbar.

Field Definitions:

Product
Product #:  You may enter a number, text or both here. This
field is automatically capitalized so you can easily find the
product later. You can also wand a bar code into this field.
The Product # can accommodate up to 15 characters.

Tip:  If more than one vendor supplies you with the same
product, enter the product twice, but with different
product numbers.

Description:  Enter up to 30 characters to help you identify
this product when viewing your inventory.

Supplier:  You can select a Product Supply Vendor here to
associate the product with its supplier. If you have not added
the supplier yet, you can make the association later by
editing the product.

Tip:  If a vendor provides you with several products, enter
the vendor first then, while in the Product Supply
Vendor form, click the Products tab then the Add
button. Each product you add will be associated with
that vendor.

Order Message:  This 50 character message will be
displayed when the product is selected during an order. It is
a convenient way to add reminders to products (for example:
"This item requires batteries."). Note: This message may be
used effectively with the Message for new order which
shows on the Order Entry screen.

Ship Cost:  This is the cost to you to ship this individual item.

Ship Extra Charge:  If this product requires an additional
shipping charge to the customer (for example, oversized
items), enter the amount here. When a customer orders this
product, the extra shipping charge will be added to the total
sale.

Drop Ship Item:  If you do not stock this item, but have a
third party ship it to your customer, check this box.

Stock Levels
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Reorder at:  You can specify the quantity this item may
reach before Mailware reminds you to order more.

Reorder Qty: The number of items to order when the
Reorder at threshold is met.

EDIT A PRODUCT SUPPLY VENDOR

On the Company Database form click the Inven button, then
click the Tables tab. Select Product Supply Vendors from
the list, and click the Open button.

Shortcut:  You can open the Product Supply Vendor form

with the Vendors icon . You can then scroll through all
your vendors using the navigator buttons  on the
toolbar, or you may search for a vendor by using the Find

icon  on the toolbar.

After you have located the vendor you wish to edit, you can
simply tab to or click on the fields you wish to change, and
enter the new information, or you can click the edit button

 on the toolbar.

Field Definitions:

Vendor Information
Enter each vendor, and contact information. If you make all
your own products, enter your company information here.

Products
These are the products associated with this vendor. If you
wish to add a product,, or edit a product you will be taken to
the Products form.
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Tip: If more than one vendor supplies you with the same
product, enter the product twice in the Products form,
but with different product numbers.

Tip: If a vendor provides you with several products, enter
the vendor first then while in the Product Supply
Vendor form, click the Products tab then the Add
button. Each product you add will be associated with
that vendor.

Purchase Order
This tab lists all the purchase orders you have created for
this vendor. You can view or edit any purchase order by
double clicking it, or clicking the Edit button. From this
screen you can also create a new purchase order.

Shortcut : You can create a new purchase order from any
tab on the Product Supply Vendor screen. Simply click the
New PO button.

EDIT A PUBLICATION

On the Company Database form click the Ads button, then
click the Tables tab. Select Publications from the list, and
click the Open button.

You can then scroll through all your publications using the
navigator buttons  on the toolbar, or you may

search for a publication by using the Find icon  on the
toolbar. After you have located the publication you wish to
edit, you can simply tab to or click on the fields you wish to
change, and enter the new information, or you can click the

edit button  on the toolbar.

Field  Definitions :

Title : A publication may be anything from a magazine to a tv
station. The title you enter will be the publication name used
when you add a source key.

Media : Trade refers to a publication for a specific industry
(e.g., Direct is a trade newspaper for the mail order
industry). Card Decks are 3x5 cards mailed in packs of
about 100 other cards.

Circulation : The number of items sent to subscribers or
recipients.
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EDIT A SALES TAX TABLE

On the Company Database form click the Sys button, then
click the Tables tab. Select Sales Tax Tables from the list,
and click the Open button. 

To change Sales Tax information simply type the new data

over the old, or click the Edit button  on the toolbar. .
Type the name of the agency to whom you are remitting
sales tax in the Location column, and enter the percent in
the Tax% column as a decimal (e.g., enter 6% as 6, 6.5% as
6.5 etc.). When you take an order the Sales Tax Table is
available as a pull down list in the Payment section of the
screen.

To delete an item from the table, select it and click the

Delete button  on the toolbar. You will be asked for
confirmation.

To cancel a change click the Cancel button . All additions
and changes are saved when you exit the form, or you can

click the Post button  on the toolbar.
EDIT A SHIPPING VENDOR

On the Company Database form click the Sys button, then
click the Tables tab. Select Shipping Companies from the
list, and click the Open button. 

To change Shipping Vendor information simply type the new

data over the old, or click the Edit button  on the toolbar.
Type the name of the shipping company (up to 10
characters) in the Shipper column, and enter the type of
service (up to 30 characters) in the Description column (e.g.,
enter USPS as the Shipper, and Post Office 3day Priority
Mail as the description). When you take an order the Ship
Via pull down list in the Shipping section of the order entry
screen will contain all your Shipping Vendors, and each
service you entered.

To delete an item from the table, select it and click the

Delete button  on the toolbar. You will be asked for
confirmation.

To cancel a change click the Cancel button . 

All additions and changes are saved when you exit the form,

or you can click the Post button  on the toolbar.
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EDIT A SOURCE KEY

On the Company Database form click the Ads button, then
click the Tables tab. Select Advertising Source Keys from
the list, and click the Open button.

You can then scroll through all your source keys using the
navigator buttons  on the toolbar, or you may

search for a source key by using the Find icon  on the
toolbar.

After you have located the source key you wish to edit, you
can simply tab to or click on the fields you wish to change,
and enter the new information, or you can click the edit

button  on the toolbar.

Field  Definitions :

Source  Key : Enter the code, you have assigned for a
particular ad, mailing or catalog. This is your Advertising
Source Key. 

Description : Enter any text you wish in the next field.
Starting the description with the publication date of an ad is
a handy reference (e.g., 1/97).

Type : This refers to the type of ad (e.g., display or classified
ad in a magazine, a direct mailing etc.)

Catalog : Use this type to activate the Catalog drop box

below this field where you can associate a Catalog with this
source key.

Classified : Classified ads are typically either One Shot or
Two Step ads: One Shot ads ask for the order. These are
effective only for very low priced items. Two Step ads offer a
free or inexpensive sample or demo. The sample is mailed
with sales literature that asks for the order.

Display : These are usually large ads ranging from 1/8 of a
page to a multiple page spread that appear in a publication.
Because display ads are expensive, and offer you room to
describe your product they typically ask for the order, and
offer higher priced items.

Direct : Direct Mail usually consists of several pieces mailed
directly to a potential customer. The components of a direct
mail package may include: a sales letter, an order form, a
publisher's note and a brochure. By assigning a source key
to the entire package Mailware can track the effectiveness of
a direct mail campaign. You can also assign different source
keys to different parts of a direct mail campaign.

For example, you could create 2 different direct mail
packages, and assign each a different source code. Or, you
could send the same package to 2 different lists, each with
its own source code. By combining both of these methods
you can create several distinct groups all within the same
mailing. This is a very effective method for testing.

Internet : Use this type for Internet ads and search engines.

Other : Use this for an ad that does not fit one of the
available categories.
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Publication : Select a Publication, if applicable, from the cost of postage here.
drop down list, or add a publication and return here to select
it. Mailing : Any additional costs to mail can be separately

Catalogs : Source Keys may be assigned to a catalog once,
or you may assign several to the same catalog. This allows Tip: Create source keys that have meanings to you. For
you to measure the effectiveness of the same catalog sent example, DM197 for a direct mail piece you sent in
to different customers, or at different times.. Enter the January 1997.
appropriate catalog here from the drop down list, or add a
catalog, and return here to select it.

Date: Enter the date you actually placed the ad (not its
publish date), or mailed a campaign.

Renew  Date: If you plan to advertise in this publication
again enter the deadline for submitting a new ad in the
Renew Date field.

Mailings : Enter the number of pieces you mailed, or the
circulation for the publication in the Mailings field.

Advertised  Products : You can associate up to three
different products with this ad by selecting them from the
drop boxes in the Products fields. If you have multiple items
you can set up a catalog, and refer to it in the catalog field
above.

Ad  Price : This is the actual price for a classified, display or
other paid ad. Do not include printing, postage or mailing
costs which are provided for below.

Printing : Enter any printing costs associated with this ad.

Postage : For mailings you can separately record the total

recorded in the Mailing field.
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EDIT AN ORDER EDIT THE ZIP CODE TABLE

On the Company Database form click the Order button, then
click the Tables tab. Select Orders from the list, and click the
Open button.

You can then scroll through all your orders using the
navigator buttons  on the toolbar, or search for a

order with the Find icon .

Shortcut:  You can use the Find Order icon  to quickly
locate the order. Or, use the Find Customer icon  then
choose the Order tab on the customer screen.

After you have located the order you wish to edit, you can
simply tab to or click on the fields you wish to change, and
enter the new information, or you can click the edit button

 on the toolbar.

See the Add an Order (p. 3.42) section for information about
the fields on the Order Entry screen.

Mailware comes with a complete Zip Code database. You
can access it at any time to make changes or corrections.

On the Company Database form click the Sys button, then
click the Tables tab. Select Zip Code Tables from the list,
and click the Open button. 

To change Zip Code information simply type the new data,

or click the Edit button  on the toolbar. 

To delete an item from the table, select it and click the

Delete button  on the toolbar. You will be asked for
confirmation.

To cancel a change click the Cancel button . 

All additions and changes are saved when you exit the form,

or you can click the Post button  on the toolbar.
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ENTER MY COMPANY INFORMATION EXPORT DATA

From the text menu at the top of the Mailware screen click
on Tools then select Preferences. Click the Company Info
tab.

To change any information, simply tab to or click on the field
you wish to edit, and type the new information. Click the OK
button when you are done.

Exporting your Mailware data is accomplished with the built
in report writer. Any report can be exported as an ASCII or
database file. First preview a report you wish to export.
Then,

1. Choose File , then Export  from the report writer’s text
menu.

2. In the dialog that opens choose a file type:

Paradox (.DB)  - Mailware’s native data format

Dbase (.DBF) - A standard database format

ASCII Delimited - Text file with double quotes around
fields and commas between them 
(e.g., “Field1".”Field2"). This is a common generic
format for most programs.

ASCII Fixed  - Text format with unformatted fields

.SHZ - The report writer’s compact report distribution
format. .SHZ files can be read with Mailware’s
distributable report viewer.

3. Type a name in the File Name  field (or use the browse
button) and click OK. The file is saved by default to
your Mailware directory (C:\Mailw15), and can be
imported into any software that supports one of the
above formats.
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FILTER RECORDS

On the Company Database form click the All button, then
click the Tables tab. Select Customers (or any table you
wish to filter) from the list, and click the Open button. Then

click the Filter icon  on the toolbar.

Filter is an advanced form of search that makes it easy to
find exactly the records you want. When you use the Filter
on the Customer screen, for example, you can tell it to
display all customers with the last name Smith. Follow the
steps below to try it now.

Open the filter as described at the top of this page. When
the Filter screen pops up, type Smith (the cursor will be in
the Field Value in which you need to type, and the default
filter of last name is selected for you). Click the OK button
and you will return to the Customer screen. Now, however,
only customers with a last name starting with Smith will be
displayed (assuming you have any). You can scroll through
them with the navigator buttons  on the toolbar

Filter can work on several fields at a time so you can, for
example, find all the customers whose first names start with
the letter B, and who have a last name starting with Smith.
You can try it now too. Open the Filter again, then click the
All tab at the bottom left of the dialog. From the list of fields
choose First Name, then in the Field Value type B. Click the
OK button, and all customers with the last name of Smith,
and a first name beginning with B are displayed.

You can use Filter with any table in Mailware to choose
which records you wish to see. Use it to display specific
Products, Purchase Orders for selected vendors, Inactive

Customers and much more. 

Tip: To turn off the Filter, open it with the Filter icon ,
and click the New Search button at the bottom of the
dialog, then click OK.

Field  Definitions :

Fields  Select a field to Filter on by left clicking it in the Field
window. Then type the Filter criteria in the Field Value to the
right. You can repeat this process for as many fields as you
wish, then click the OK button to view the results. The All tab
displays all available fields for filtering. The Searched tab
becomes active after you have completed at least one filter.
It displays only the fields you have used so far. When the
Searched tab is active you can click the All tab to select
additional fields for filtering.
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Field  Order  Select Alphabetic to sort the fields in the
window by their names. Select Logical to sort them by their
order in the database. This selection only affects the method
used to sort the fields in the filter dialog. It does not affect
the table you are filtering.

Field  Value  Type the filter criteria for the currently selected
field. For example, if you have selected Last Name in the
Fields section, type the customers' last name on which you
wish to filter (e.g., Smith).

Search  Type  You can choose to have a field exactly match
the Field Value you type, or match only part of it. For
example, choosing Partial Match at Beginning and filtering
on a last name of Smith would find customers with the name
Smith, Smithers and Smithy. The Case Sensitive check box
forces the filter to match upper and lower case letters. Select
the By Value tab when you want to find records that match
the Field Value. Use By Range when you want them to be
part of a group (e.g., between 2 dates).

View  Summary  Displays a list of your filtering criteria.

New Search  Starts a new filter. Can also be used to clear all
filters.

Tip: When creating Advertising Source Keys, Product
Numbers and other fields keep the Filter function in
mind. It can be useful later when you want to see only
your Products, for example, that are stored on aisle 3,
shelf B if they all have a description starting with 3B.

FIND A CUSTOMER

On the Company Database form click the Cust button, then
click the Tables tab. Select Customers from the list, and
click the Open button. You can scroll through all your
customers using the navigator buttons  on the

toolbar, or search for a customer with the Find icon  (See
Also - Filter Records).

Shortcut:  Click the Find Customer icon  on the toolbar.

Enter any data you wish to use for the search, and click the
Search button. Mailware will display the customers it finds in
the bottom of the window. Select the customer you wish,
and click the OK button. You will then see that customer's
information in the Customer screen.
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Field Definitions:

Name & Number
Search on field exit  If this box is checked Mailware will
begin searching immediately after you enter an item, and
press the tab key (e.g., if you type the customer's first name
and press tab to jump to the Last Name field Mailware will
begin searching for all customers with the first name you
typed).

Additional Info
This tab includes search fields that are not part of the
customer's name or address (e.g., phone number).

FIND A PRODUCT

On the Company Database form click the Inven button, then
click the Tables tab. Select Products from the list, and click
the Open button. 

Shortcut:  You can open the Product form with the Inventory

icon .

You can then scroll through all your products using the
navigator buttons  on the toolbar, or you may

search for a product by using the Find icon  on the
toolbar (See Also - Filter Records).
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Find an Order

On the Company Database form click the Order button, then
click the Tables tab. Select Orders from the list, and click the
Open button. 

You can then scroll through all your orders using the
navigator buttons  on the toolbar, or you may

search for an order by using the Find icon  on the
toolbar.

Shortcut : You can use the Find Order icon  on the
toolbar.

Tip: You can search for a customer as described in Find a
Customer (p. 3.102), then open any of that customer’s
orders from the Orders tab on the Customer screen.
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IMPORT DATA

From the text menu at the top of the Mailware screen click
on Tools then select Import. The Import Wizard will pop up
to assist you with the process.

Shortcut : Click the Import icon  on the toolbar.

When the Import Wizard opens simply follow the on screen
prompts. NOTE: Always test with a small file first.

Field  Definitions :

Type of Import:  Select the type of data you are importing
(e.g., if you are importing a rented list, the type is customer.)

Source  File : If you know the name, and path of the file you
are importing type it here (e.g., a list on a 3.5" diskette may
be A:\CUSTOMER.DB). Otherwise, click the Browse button,

and select the file from the dialog that pops up.

Destination  Fields : These are Mailware's fields (e.g., the
customer's Last Name is the field "Last Name" that is
viewable in the Customer screen). Match these fields to their
counterparts in the source file. 

Note: To match fields click the Destination Field in the left
window, then click the Source Field in the right window that
contains the same data (the names of fields may vary - e.g.,
Last Name = LName etc.). As you match fields click the
Equal Sign button to add them to the Matches window.
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Source  Fields : These are the fields in the file you are where you received the imported file.
importing. Match them to Mailware's Destination Fields as
described above. We also recommend you run the Import Data online tutorial

Matches : As you match fields the groupings will appear
here. If you make a mistake you can select the incorrect The main help file contains additional information that may
match and click the Delete button. You do not need to match be useful including data layouts for various tables. Layouts
all fields, however, unmatched source fields will not be describe what the fields in each table mean (for example,
imported. the LastName field in the Customer table stores the

When you click the Finish button the records will be provided to assist you with matching fields when using the
imported. Depending on the size of the file you are importing import wizard, and for advanced use when importing data
this may take a few seconds, or a few minutes. directly into Mailware’s tables.

Tip: When importing anything you match in the import
wizard will be imported (for example, you can import a
first name into a phone number field). Always test with
a small number of records before importing. It is also
wise to back up your data directory before importing.
Imported records must be deleted manually if you
make a mistake, or you can restore your backed up
data directory.

You can also add fields to your source file so the import
will update the newly imported records. For example, you
can add a field to each customer record you are importing
that contains an ad source key. Then match that field to
the Original Source Key in Mailware. Every imported
customer will then contain that key in the Additional Info
tab of the customer screen. Be sure to add the key to your
Ad Source Key screen manually. It is not mandatory to do
so (the key will import regardless), but it will keep a record
of what the key means. This is a good way to keep track of

available from the Help menu in Mailware. 

customer’s last name, may contain alphabetical characters
and can be up to 20 characters long). This information is
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RECEIVE INVENTORY

On the Company Database form click the Inven button, then
click the Actions tab. Select Receive Inventory from the list,
and click the Open button.

Use the Receive Inventory action to record items received
for open purchase orders. Mailware will automatically update
stock levels for items you enter as received.

Field  Definitions :

Vendor  Name: Select the Product Supply Vendor for the
items received.

Receive  Dt: This defaults to today's date, but can be
changed to reflect the date items were actually received.

Invoice  #: Enter the vendor's invoice number that was sent
with the order, if applicable.

Invoice  Dt: Enter the date of the invoice from the vendor, if
applicable.

PO Number : You can select a single purchase order from
the drop down list, or click the Select... button to work on
multiple purchase orders. A dialog will pop up, and you can
check off the purchase orders you wish to work with.

Items Received : The products entered on the original
purchase order(s) will be entered here automatically. The
following fields will be filled in, and may be edited as
described below.

Product  This is your product number for the items ordered.
If your vendor substitutes a different item you can select it
here by clicking on the field, and choosing an item from the
drop down list. If the item is not already in your inventory,
you can add a product, then select it here.

Description  This is your product description for the product
number in the Product field.

Qty  This is the number of items ordered as shown on the
purchase order.

Rcd  Enter the number of items received here. This number
will be added to your inventory when you complete the
action by choosing the Save or Add button. You can enter a
number that is greater or less than the number ordered.

Amount  This is the per item cost to you, and is entered
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automatically based on the cost entered in the original Show PO # in grid : When this box is checked the Items
purchase order. This amount can be changed to reflect the Received section will display the purchase order number for
actual amount charged to you. each item rather than the Total.

Total  This is calculated for you based on the number of
items received, and the amount per item you enter. This field Note: Amounts you pay for items will be reflected in each
is not visible when the Show PO # in grid check box is affected purchase order's Paid field. Shipping, Tax and
checked. Adjustment amounts are associated with the vendor's

 PO # When you select the Show PO # in grid check box the these amounts later, open the Receive Inventory Action,
purchase order number for each item is shown instead of
the Total.

Items  Total : This is the subtotal of all items from the Items
Received section.

Shipping : Enter any shipping amounts you were charged.

Tax: Enter any tax amounts you were charged.

Adjustments : Any adjustments from the vendor's invoice
may be entered here (e.g., allowances for lost or damaged
items, discounts etc.)

Total : This is the grand total for all selected purchase
orders, and is calculated for you. Each purchase order will
show its own total in the paid amount field on the purchase
order.

View PO... : Click this button to open the purchase order for
the currently selected item.

invoice number, and are stored with the Action. To review

then use the navigator buttons  on the toolbar to
scroll to the appropriate invoice.
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REFUND AN ORDER

If you are not already viewing the order you wish to refund
go to the Company Database form click the Order button,
then click the Tables tab. Select Orders from the list, and
click the Open button.

You can then scroll through all your orders using the
navigator buttons  on the toolbar, or search for a

order with the Find icon . You can also search for a

customer with the Find Customer icon  then select an
order from that customer’s order history (the Orders tab on
the Customer screen).

Shortcut:  You can use the Find Order icon  to quickly
locate the order.

Once you have located the order you may refund all or part
of it. First, select the first product you wish to refund (by
clicking on it in the grid on the Order form). Then, click the
Item button and select Refund .

In the dialog that appears type the number of items you wish
to refund. The quantity you enter will appear in a separate
line item on the grid.

Repeat this process for all items you wish to refund then
click the Save button to close the form. Or, refund all items
in an order simultaneously by clicking the Order  button and
selecting Refund .

Note : An item must be shipped (i.e., have a status of SH)
before it can be refunded. To mark an item as shipped,
select it then click the Item or Order button on the order form
then select Mark Shipped .
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SET UP CREDIT CARDS

On the Company Database form click the Sys button, then
click the Tables tab. Select Credit Cards from the list. To set
up a new card click the Add to button

Or,

To edit an existing Credit Card click the Open button. You
can then scroll through all your Credit Cards using the
navigator buttons  on the toolbar, then simply type

the new information, or click the Edit button  on the
toolbar. 

To delete a Credit Card, click the Delete button  on the
toolbar. You will be asked for confirmation. 

Field Definitions:

Card Information
Card Code : This is a short code to describe the card (e.g.,
Visa) This field appears on the Order Entry screen when you
select the Credit Card in the Payment section.

Card Type : You can use a longer name here to better
describe the card code.

Merchant Information
Account # : This is your account number with your Merchant
Services Provider.

Auth Phone # : Enter either the voice or data number you
dial to authorize credit card charges.

Merchant Name and Address : You can enter the name
and address of your Merchant Services Provider here.
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UPDATE THE CUSTOMER CONTACT LOG

On the Company Database form click the Cust button, then
click the Tables tab. Select Customers from the list, and
click the Open button.

You can either add a new customer now by clicking the Add
button (for help see How to Add a customer,), or you can
search for an existing customer.

Shortcut:  You can use the Find Customer icon  to
quickly locate a customer.

Tip: Use the contact log to assign an Original Source Key
when adding a customer.

After you have added or found or added your customer, click
the Contacts tab. Any existing contacts will be visible, and

can be edited by selecting one, and clicking the Edit button.
You can also enter new contact information with the Add
button, or the New Contact button.

Field  Definitions :

Source  Key : Enter the Advertising Source Key associated
with this contact. You may wish to create special keys just
for customer contacts, by adding a source key.

Action : Select an appropriate action from the pull down list,
or choose Other, and specify the action in the Notes field.

Notes : Enter any information you wish here including
reminders to complete future tasks.

Tickle  Date: A tickler report can be created each day that
reminds you which tasks are due based on the date you
enter in this field. Use this to remind you and your staff to
mail letters, fill book club type orders, charge on payment
plans etc.

Operator : Enter your Operator ID here, or the ID of the
person who will be completing the tickler.
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VIEW CUSTOMER HISTORY

On the Company Database form click the Cust button, then
click the Tables tab. Select Customers from the list, click the
Open button then click the Contacts tab.

Shortcut:  You can use the Find Customer icon  to
quickly locate a customer.

Double click any entry to open the Customer Contact log,
and view its details.

Field  Definitions :

Source  Key : Enter the Advertising Source Key associated
with this contact. You may wish to create special keys just
for customer contacts, by adding a source key.

Action : Select an appropriate action from the pull down list,
or choose Other, and specify the action in the Notes field.

Notes : Enter any information you wish here including
reminders to complete future tasks.

Tickle  Date: A tickler report can be created each day that
reminds you which tasks are due based on the date you
enter in this field. Use this to remind you and your staff to
mail letters, fill book club type orders, charge on payment
plans etc.

Operator : Enter your Operator ID here, or the ID of the
person who will be completing the tickler.
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Mailware’s report writer is one of its most useful and
versatile features. You can, of course, simply print the
included reports as you need them. See the section How to
Print Reports (p. ?.?). But, you can also edit reports to
include more information, to change how they look or even
to add a graphic of your company logo. And, with a little
practice you can create your own custom reports from
scratch.

Editing Reports
Mailware includes over 100 pre-built reports. Although they
are designed to meet most needs, you may wish to alter
them for your particular business. You can make minor
changes, like moving fields around. Or, you can use a report
to make a completely new one (for example, you could turn
an invoice into a payment coupon).

Let’s start with a simple change to one of the existing
reports.

Exercise 1: Adding a Note to an Invoice

1. Open the Report Explorer. Locate the Invoice/Date
Range  report (under Operations Reports>Orders )
and double click it.

See Finding Reports (p. ?.?) for instructions on locating
and opening reports.

2. The Report Writer will open to the Define Search tab.

The Define Search tab in the Report Writer contains the tables and
fields used in the report.

3. Click the Preview Report  tab to see the report as it
stands now. When prompted, enter a date range that
includes orders (if you are using the sample database
use 11/9/98 for the start and end dates).

4. After you finish previewing the invoice, click the
Layout Page  tab to go to an editable preview of the
report.

The following screen will appear (you may need to
maximize the Report Writer to see the whole page).
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The Layout Page displays a preview of your report you can edit by
dropping fields onto it and dragging them into place.

5. Now we will add a message to the bottom of the
invoice (to the left of the Subtotal). Click the Page
Designer icon  on the toolbar and in the dialog that
opens click the Place  tab.
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6. On the Page Designer dialog click the Label button 10. After you finish resizing the field click anywhere in its

. The button depresses to indicate that you can
now place a label field on your report.

7. Click anywhere on the report to place the label field.
The Label button will pop up and a field with the word
Label  in it will appear. The field has small black
handles on it to show it is selected (If the Page
Designer is in your way you can close it by clicking the
X in the top right corner.).

8. We will be placing our message in the blank area to
the left of the Subtotal. However, there is already a
field there (a large grey outlined box), which we are
not using. To delete it, click once anywhere on it.
Small black handles will appear to show it is selected.
Then press the Delete  key on your keyboard, and
answer Yes if prompted.

8. Now, click on the Label  field we created a moment
ago, and drag it to the blank area to the left of the
Subtotal.

9. The field is too small for a message. To make it bigger
move the cursor over a black handle. When it  turns
into a double-headed arrow left click and drag the field
to a size that fills the blank area.

center and drag it into position. It should look
something like the following:

11. Now it’s time to add our message. Click on the Label
field to select it (if it’s not already). Then click the Page

Designer  icon .

12. On the Page Designer click the Customize  tab. Then,
at the bottom of the Page Designer click the Caption
tab. You should see the word “Label” in an otherwise
blank form.

13. Click on the word “Label” and use the Delete  or
backspace  key on your keyboard to delete it. Then
type the message:

Thank you for your order     

14. Close the Page Designer (click the X), and you should
see your message in the field you created on the
invoice.

15. Click the Preview Report  tab and enter a date range.
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The previewed invoice includes your message. This Invoice for Date Range with message: Thank you
same message will print on each invoice. for your order

16. To save the modified Invoice choose File , then Save
As  from the text menu at the top of the Report Writer.
In the dialog that pops up type:

Invoice/Message

Then click OK or press the Enter  key. 

Note : If you do not change the report name, or if you
choose File  then Save, the modified report will overwrite
the Invoice/Date Range report.

17. Close the Report Writer (choose File  then Exit  or click
the X in the top right corner). You will be returned to
Mailware.

18. Open the Report Explorer. Click the Orders  folder
under Operation Reports . In the right pane find and
click the report you saved - Invoice/Message .

19. When you click on Invoice/Message  note that the
lower pane contains a thumbnail icon and a blank
space. This is used to identify the report. For example,
click the Invoice/Date Range report. Notice the
Invoice thumbnail and the text describing the report.

20. Click Invoice/Message  again. Then right click the
Custom  thumbnail. Choose Invoice  from the menu
that pops up. Next, click in the blank space next to the
thumbnail and type:

The report is now part of the Report Explorer menu, and
contains a thumbnail and description to help you identify it. 

Note: Reports in the Report Explorer are stored in the
Reports.db file in your Mailware Data directory.

You can edit any of the reports and save them in this way. In
addition to adding notes, you can “Place” a bitmap of your
company logo, other fields from any linked tables (e.g., the
customer’s phone number) and boxes, lines, circles, page
numbers, dates and more. These additional items are
available from the Page Designer’s Place tab.

Exercise 2: Adding a Changing Note to the
Invoice

In the previous exercise we added a note to our invoice that
prints the same message each time. Now let’s add a
personalized note that we can change from the order entry
screen for each customer.

1. First we need to create or edit an order to contain a
message. If you are using the sample database click

the Find Order icon  on the toolbar and double click
Order #5 to edit it. Otherwise, choose an order of your
own to edit, and make a note of its order date for
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You can add a customized message to each product in an order
by clicking the Customize button on the Item Detail tab when
any item is selected in the Products section of the Order Entry
screen.

previewing the report later.

2. On the order click a product (the Garden Starter on the
sample company). Then click the Customize  button
on the Item Detail  tab at the bottom of the order.

3. In the Customize Information window that opens
type a message (e.g., “You can order additional items upper half, and the fields from these tables that are used in

from our enclosed catalog”), and click OK.

The Report Writer displays tables associated with the report. Lines
between the tables represent links (e.g., The Orders table is linked to
the Customer table by the CustNo field they both share).

4. Click the Save button on the Order form.

5. Open the Report Explorer and double click the
Invoice/Date Range  report. The report will open to the
Define Search  tab in edit mode as in Exercise 1. 

The Define Search section lists all the tables used in the

the report in the lower half. 
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You can drag fields from tables and drop them onto columns in the
Define Search tab. Only fields in columns can be “Placed” on the Layout
Page tab.

6. In order to add a customized message to each invoice
we will need to use a field from the ITEMS table (the 
ITEMS table contains the products each customer
ordered). The field we need may be included in the
columns below, but let’s add it again for practice. 

Use the scroll bar on the ITEMS table in the upper half of
the screen to find the CustomDesc  field. Then Double available fields we can choose it in Layout to place on
click it to add it to the field columns in the lower half of the our report. Click the Layout Page  tab.
screen (you can also left click and drag it to the columns).

Note:  The CustomDesc  field is associated with each
product in an order. It is the message you added in the
order by clicking the Customize  button on the Item Detail
tab

7. Use the scroll bar at the bottom of the screen to move
to the far right column. You may see 2 CustomDesc
columns (the one you added for practice, and the one

that was already part of the report). If so, click on one
(in the white area - not the grey title), then press the
Delete  key on your keyboard, and answer Yes if
prompted.

8. Because we have CustomDesc  in our listing of

9. Click the Page Designer icon, then click the Place  tab.
Use the scroll bar to scroll down to CustomDesc  in
the list of available fields.

10. Before we place the field uncheck the Automatically
caption fields  check box. This prevents a title from
being added to the report when we place the field.

11. Now click and drag CustomDesc  to a blank area on
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the report. When you release the mouse button the
field is placed.

12. Because CustomDesc  is associated with ordered
items we want it in the section of the report that
contains the items. Your report may already contain
the CustomDesc  field in the Detail (D1) section,
directly under the Product Description .

You can practice moving the field into position. First, if a
CustomDesc  field is already in the detail section click it
and pressing the Delete  key on your keyboard. Next drag
the CustomDesc  field you added to the report to the same
area (just below the Product No and Description), then left
click and drag one of the black handles to make the field
equal in size to the Description above it.

Note : In the figure above the cursor is a 2 headed arrow

. You can use it to drag the blue line that defines the
Detail area up or down to make room for the CustomDesc
field.

13. Click the Preview Report  tab to see the CustomDesc
field displayed. Notice that the field expands vertically
to display longer messages.

14. The report is already saved in your Report Explorer so
you can simply exit the Report Writer (File>Exit  from
the text menu or click the X in the top corner). Or, if
you wish to save your changes choose File>Save  or
File>Save As  from the menu.

Exercise 3: Creating a simple report from
scratch

In the previous exercises we edited an existing report. This
exercise will cover the basics of creating a simple report.
Methods learned here can be used to create new reports,
and to make more meaningful changes to the reports that
come with Mailware.

1. Open the Report Explorer and locate the Custom
Reports  folder in the left pane. Left click it once to
select it. Then, click File  in the text menu and choose
New Report  from the pop down menu.

2. In the dialog that appears type: Exercise 3  and click
the OK button. This will create a new report in the
Custom Reports folder.

3. In the right pane of the explorer double click the new
Exercise 3 report to open it.
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4. The report opens to the Define Search tab. Here we
will choose which tables and fields we will include in
our report. Let’s create a report that lists the orders
entered in Mailware.

First, add a table by clicking the Add Table icon . on the
toolbar.

5. In the dialog that appears select Mailware  from the
pull down menu in the Database  field.

6. Several tables will appear in the lower portion of the
dialog. Find Orders.db  and double click it, or click it
once then click the Add Table  button. The Orders
table will appear on the define search screen. Click
Close  to exit the Add Tables dialog.

7. The Orders table contains fields that are used in the
Order Entry screen in Mailware. To include a field in
the report double click it to add it to the columns in the
lower half of the screen. For example, let’s create a
listing of order numbers.

Find the OrderNo  field (it is at the top of the Orders table)
and double click it. OrderNo will appear in the first column.

8. Click the Preview Report tab to see how our report is
coming along. If you have orders entered in Mailware,
or are using the sample company database you will
see a listing of order numbers in a grid format. (If your
report is blank you can save and close it, then enter a

couple of orders. Or, use the File>Open Company text
menu item in Mailware to switch to the sample
database. Then reopen the report.).

9. Click the Define Search tab, and use the scroll bar on
the Orders table at the top of the screen to browse
through the fields in the table. Find TotalAmt  and
double click it.

10. Preview the report (click the Preview Report tab). You
should see order numbers listed with the total amount
of each order listed beside it. While this is useful
information a summary would be better. Click the
Define Search tab.

11. Click in one of the white cells in the OrderNo column
to select it. Then double click the cell to open the Edit
dialog.

12. In the Edit dialog for OrderNo change the Show field to
Count  by selecting it from the drop down list. Then
click the Red Right Arrow  to move to the next field.

13. Change the Show field for TotalAmt to Sum . Click the
OK button. Preview the report.

14. Your preview should show 2 fields - the number of
orders entered in Mailware and their total dollar
amount. You specified these results when you set the
OrderNo field to Count, and the TotalAmt field to sum. 

When you are ready to continue, return to the Define
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Search tab.

15. Find the OrderDt  field in the Orders table. Instead of
double clicking it, left click and drag it to the first
column (currently occupied by OrderNo). When you
release the mouse button the OrderDt field will appear
in the first column.

16. Click in the white area of the OrderDt column, then
double click to open the Edit dialog. Notice that the
Show field is set to the default of Show. Because the
other fields in the report are calculated OrderDt must
be set to a calculation or to Group. Change OrderDt’s
Show field to Group . Click OK and preview the report.

17. If you have more than one order on a given date the
orders for that date will be grouped as in the example
below on 11/9/98 which had 3 orders entered.

The report groups items based on the Order Date (as you
specified when you set OrderDt to Group). Grouping is
useful when you wish to see totals for a given day, product
type, ad key etc. 

NOTE: When any field is calculated (i.e., Sum, Count etc.)
all other fields must also be calculated or Grouped. 

18. Click the Define Search tab, then find the following
fields in the Orders table and double click them:

TaxAmt
ShipAmt
PaidAmt

19. Select the TaxAmt column, then double click it to open
the Edit dialog. Change its Show property to Sum .
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Click the Red Right Arrow to move to each of the
other fields and change their Show properties to
Sum . Click OK to close the Edit box then preview the
report.

20. The report now lists total sales for each day, and
itemizes Tax and Shipping charges. ThePaidAmt field
shows the total amount received. The difference
between it and TotalAmt is the amount still due (i.e.,
TotalAmt - PaidAmt = Amount Due). 

The above equation is simple enough to calculate
manually, but would be nice to have added to the report.
Click the Define Search tab and we will create a new field.

21. Scroll through the Orders table and you will see that
an Amount Due field does not exist. However, we can
create one. To do so double click a blank column or
click the Insert Blank Field icon   on the toolbar and
double click the column it creates.

The Edit dialog opens to the Custom Expression tab where
you can create an equation as in this example:

22. To create an Amount Due field we need to subtract the
PaidAmt from the TotalAmt. First double click the
Orders folder  (which represents the Orders table in

your report). The Orders table fields will appear in a
list.

23. Find TotalAmt  and double click it. It will appear in the
Custom Expression field as Orders.TotalAmt.

24. Next find the minus sign (-)  in the right pane and
double click it so it appears in the Customer
Expression field.

25. Finally find and double click the PaidAmt  field in the
left pane so the total equation in the Custom
Expression field now reads as:

Orders.TotalAmt -  Orders.PaidAmt 
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26. Click the Field Properties tab and change the Header
from Custom to Amount Due . Change the Show
property to Sum  and the Align property to Right . Click
OK and preview the report.

27. The report should now show the Amount Due for each
day. Let’s make one more addition to the report to
make it more useful. Currently all orders entered into
Mailware are shown. To specify orders for a given date
range we can use a special function.

Click the Define Search tab, then open the Edit dialog for
the OrderDt field (click, then double click it).

28. In the Header field change OrderDt to GetDateRange .
In the filter section of the dialog select Is Between
from the drop down list. In each of the two fields that
appear type the word Today . Your dialog should
appear as follows:

29. Click OK and preview the report. You will be prompted
for a beginning and ending date. Enter each date in
the format mm/dd/yy . If you are using the sample
database enter 11/1/98 and 11/30/98.

Your report will show totals for the date range you
specified, and will group orders for each day.

30. If you wish you can save the report. First, return to the
Define Search tab and open the Edit dialog for the
GetDateRange column. Change the dates to Today
and click OK. This causes the date range to default to
Today if no dates are entered when prompted. Next,
choose File  then Save As  from the text menu. You
can enter a different name (e.g., Accounts Receivable)
or simply click OK to overwrite the existing Exercise 3
report.

Note: Because the report is saved in the Reports.DB file in
the data directory you are working in it will not be available
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if you switch databases (See Switching Databases p. ?.?). All the data you enter, including reports in the Report
However, you can export it to an .SRW file, then switch Explorer, is saved by Mailware in a single directory. You can
databases, open the Report Explorer and import the .SRW back up your Mailware data by simply copying the data
file. directory to another media (tape, Zip disk, a separate hard

The report you created in this exercise used most of the
basic elements of the Shazam Report Writer (with the
notable exception of linking multiple tables which will be
covered later). You can use these methods to create new
reports and to edit the reports that come with Mailware.

drive). Use the following instructions to make a back up.

NOTE: It is recommended you back up your data daily, and
before applying any upgrades or changes.

How To Back Up Your Mailware Data

1. Exit all copies of Mailware.

2. Determine the location of your data directory (or
directories). 

a. When you install Mailware it defaults to the sample
company data (C:\Mailw15\SampData or the
\SampData folder in the location you specified when
installing Mailware). It is unlikely that you will use this
for your company data, however, if you chose to do so
this is the data directory to back up.

b. When you change to the Local Database to begin
entering your company data Mailware uses the default
local data directory (C:\Mailw15\Data or the \Data
folder in the location you specified when installing
Mailware). This is the most commonly used data
directory.

c. If you are running Mailware on a network  your data
directory may be installed anywhere. You can check
the location of a network data directory by opening
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Mailware and choosing File>Open Company  from the
text menu. The network directories are listed in the
lower portion of the dialog. Click each one and then
click the Edit  button to see the full path to the data
directory. Back up each directory you use.

d. If you are running multiple data directories  (e.g.,
multiple companies with their own data directories)
your data directories are stored identically to the
network directories described in item c above.

3. Choose a back up method.

a. Manual back ups  can be performed by simply
opening Windows Explorer and browsing to the
Mailware data directory. Then drag the entire \Data
folder(s) to another device (e.g., a physically separate
hard drive, a Zip drive etc.).

b. Automatic back ups  are created with the software
that came with your back up device. For example,
back up software is provided with most tape drives.
Follow the instructions for using the back up software,
and include the Data directory or directories you
identified in step 2 above.

Mailware Technical Reference
This section outlines Mailware’s directory and file structure,
and provides descriptions for various items.

Mailware is a 32 bit application written in Delphi - a rapid
application development package based on Pascal and
distributed by Borland. Its database is Paradox 5 for
Windows (.db).

FOLDERS

When installed with the default settings Mailware creates the
following directory structure:

C:\Mailw15
|
|-Data 
|
|-Mailpriv
|
|-Reports
|
|-Sampdata

C:\Program Files\Borland International Copyright 1996\BDE3.5

C:\Program Files\Borland\Common Files\BDE

The Mailw15 folder  contains the Mailware application
(.exe), help and support files.

The Data folder  contains the Local Database.  This data is
blank when installed (with the exception of the Zip Code
database), and is the default location for entering data on a
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single install of Mailware. This is the folder that is selected use for another company. Mailware owners may also use
when “Local Database” is selected from the File>Open this method, however, the Network Databases are easier to
Company option on the text menu in Mailware. Copying this use and you may create as many as you wish.
directory to another device or media effectively makes a
backup of your data.

The Mailpriv folder  is the private directory for the copy of to manage its database. The BDE creates directories on
Mailware installed on each PC. This folder is used to store your C: drive, and requres the installation of version 3.5,
temporary database files, and other miscellany. Its location then an upgrade to 5.0. As new BDE installations are made
can be changed in Tools>Preferences>Network in Mailware, available they will be incorporated into the Mailware install. 
however, accepting the default folder is recommended.

The Reports folder  contains native .SRW files. These are item in Mailware or from the Windows Control Panel
text based files that can be read and saved by Mailware’s (Start>Settings>Control Panel>BDE Administrator). Within
internal Shazam Report Writer. These reports are provided the administrator are settings that may need adjustment for
for backwards compatibility with versions of Mailware prior to use on your PC or network. Changes to the administrator
1.7, and are readily accessible from the Reports tab on the are documented in the Mailware installation manual.
Company Database. Newer reports are available from the
Report Explorer in Mailware. These newer reports are stored
in the Reports.db file in each Data folder.

The Sampdata folder  contains the Sample Database  which
is selected by default when Mailware is installed. It is
identical to the Data folder with 2 exceptions: the Zip Code
database contains only a few sample entries, and the other
databases contain pre-entered sample customers, orders
etc. for use with Mailware’s tutorials. To point Mailware to
the Local or a Network database choose File>Open
Company from the text menu and select the desired
database. 

Note to Mailware Home Office owners:  You can delete
this directory, then install a blank database to the \sampdata
folder. This effectively creates a second database you can

The Borland Database Engine (BDE)  is used by Mailware

You can access the BDE Administrator from the Tools menu
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Other folders may also be created when additional utilities upgrade will save the data structure to this folder. Your
and updates are installed. current database can then be updated to the new structure

C:\Mailw15 or from its icon in the Mailware program group.
|
|-MWScan The MailData\Data folder  is created when a Network
| Database is installed from the CD. This data folder can be
|-Report Viewer used on a network or to create a separate database for an
| additional company. Use the File>Open Company text menu
|-nwdbv17x option in Mailware to create a Network Database for this

C:\MailData this database by selecting it from the list.
|
|-Data Note to Mailware owners:  You can install as many

separate data folders as you wish, and then add them into

The MWScan folder  contains the database repair utility text menu). These databases can be used for separate
which can be installed from the Mailware CD. This companies, archiving data etc.
application (dtutil.exe) can be run to rebuild Mailware’s
database files when they are corrupted by a system crash or
unstable network.

The ReportViewer folder  contains a view-only version of
the Shazam Report Writer that is included in Mailware. The
viewer can be distributed to vendors, fulfillment houses etc.
then reports can be saved in compact .SHZ format for
distribution. A utility on the Mailware CD can be used to
create 3.5" installable copies of the viewer for distribution
(choose Launch the Installer from the Welcome dialog, then
click More> on the menu that appears).

The nwdbv17x folder  is created by updates to Mailware
that require an upgrade to the database. When new features
require new fields and/or tables the installation of the

by choosing the database upgrade option during the install

folder. File>Open Company can then be used to switch to

your Network Databases list (File>Open Company from the
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FILES

The following files and file types are stored in the folders
listed.

C:\Mailw15

& Mailware.exe (the main Mailware application)
& .HLP files (various help files)

C:\Windows
& .INI files

C:\Mailw15\Data

& .DB files
& .LCK files
& .NET files
& Reports.DB, .MB etc.

C:\Mailw15\Reports

& .SRW files
& .SHZ files

C:\Mailw15\Mailpriv

& .LCK files

.INI files  are text files that contain system preferences and
other information specific to your installation of Mailware.
The Mailware.INI  file in each PC’s Windows directory
(C:\Windows) contains information from Mailware’s
Preferences settings (Tools>Preferences). Mailwnet.INI  in
the Windows directory contains preferences specific to each
workstation on a network install of Mailware.

.DB files  are Mailware’s main database files. These contain
your data (e.g., customers, orders etc.). They are in Paradox
5 for Windows format and may be viewed with other
database management programs like Access97. You can
also view .DB files with the Shazam Report Writer that is
included in Mailware. In addition, the report writer can be
used to export data in .db, .dbf and ASCII format (Preview
any report, then choose File>Export from the report writer’s
text menu).

.LCK files  are created by the BDE when Mailware is
opened. These files track which tables and records are
accessed, and exhibit warnings when two or more people
attempt to access the same record (e.g., If one workstation
on a network is using Mailware to update John Smith’s
customer file, and another workstation attempts to open the
same customer’s account a message will appear warning
the second person that the account is being updated).

.NET files  are created by the BDE when Mailware is started.
Like .LCK files .NET files are used to track access to the
database. 

Occasionally .LCK and .NET files will prevent access to
Mailware’s tables. This occurs when .LCK files are not
deleted by Mailware due to a system crash or network
problem, or when .NET files are created in multiple
locations. To correct the problem exit Mailware on every
workstation then delete any .LCK and .NET files on each
PC. For more information refer to Deleting .NET and .LCK
files in the Network Troubleshooting section of this manual
p. A.14.

Reports.DB, .MB etc.  files contain the Report Explorer
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reports. You can access the Report Explorer from Mailware
by clicking its icon on the toolbar. .SRW files can be
imported into and exported from the Report Explorer.

.SRW files  are report files which are created with Mailware’s
internal Shazam Report Writer. .SRW files are text based
and can be read with a text editor like Notepad. .SRW files
can be imported into Mailware’s Report Explorer. Reports in
the explorer may also be exported to .SRW format. .SRW
files are useful when sharing reports with other owners of
Mailware. Unlike .SHZ files they contain no data.

.SHZ files  can be created with Mailware’s internal Shazam
Report Writer. These are compressed files that contain
report results. You can send these report results to third
parties who may view them with Mailware’s distributable
report viewer (available on the Mailware CD). Unlike .SRW
files .SHZ files contain data. For example, you can save a
day’s invoices in .SHZ format then send the file to your
fulfillment house for printing and shipping.

Troubleshootin g

I have installed Mailware, but cannot find its
icon in my Windows 95 Start menu.

You can set up the icon yourself, if for some reason it does
not appear in your Start menu. First, click on the Start button
on the task bar. Move the cursor to Settings, then click on
Taskbar. Click on the Start Menu Programs tab, then click
the Add button. Type C:\Mailware\Mailware.exe (if you
installed Mailware in the default directory). Or, click the
Browse button, then double-click on the folder where you
installed Mailware. Double-click on the Mailware.exe file (it
has an icon next to it of a red M with a white star).

Click the Next button, then click the New Folder button A
new menu item will appear ready for you to input a name.
Type Mailware, and press Enter. Type Mailware for the new
shortcut name, the click the Finish button. Mailware is now
available from the Start menu.

What is a Key Violation?

This error message pops up when you attempt to enter an
item with the same key field as an existing item. For
example, the key field for Products is the Product Number. If
you enter a Product Number of “Widget” in inventory, and
Widget already exists you will receive the Key Violation
message. Try a different key field, or check the existing item
to verify you are not entering the same item twice.
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I keep getting messages that say SHARE is not
active.

This can occur on peer to peer networks (like Windows 95).
From Mailware's Tools menu item select BDE Configuration,
and click the Help button on the message that appears.

What does this message mean? This file has
been locked by C:\....PDOXUSRS.LCK

This message typically occurs when you experienced a
system crash while Mailware was open. A Lock file did not
get a chance to close, so it is reporting to Mailware that
someone else is using a file. To fix the problem, close all
running copies of Mailware (including those running on a
network). Use Windows Explorer to locate the Mailware Data
directory (default is C:\MAILW15\DATA), then delete all files
with an extension of LCK (e.g., PDOXUSRS.LCK). See also:
Deleting .NET and .LCK files in the Network Troubleshooting
section of this manual p. A.14.

I entered an item (e.g., an Ad Source Key) then
tried to select it in a drop down field, but it was
not there.

It's there, but the field did not "refresh." You can type the
entry exactly as you set it up (including upper/lower case).
Or, you can close the screen you are working on, and
reopen it. The field will then be visible. You can also try
moving to the next record with the navigator buttons, then

returning to the record you were working on (for example, on
the customer screen the Contact tab does not refresh when
you enter a New Contact. Try moving to the previous
customer with the navigator button on the toolbar (the left
arrow), then return to the current customer.)

Where can I get updated files?  

There may be last minute updates on a disk that came with
your package, or patches on the CD. You can simply put the
disk the disk in your floppy drive and run patch001.exe, then
patch002.exe etc.. Or, follow the instructions on the CD
installer for loading patches.

All updates are available on our web site too. Visit
www.Mailware.com  and choose Upgrades  from the Quick
Find field. While you are visiting you can also register to
receive notification via email as new upgrades are made
available.
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NETWORK TROUBLESHOOTING TIPS OPTIMIZING YOUR NETWORK

The integrity of your network is paramount when running any
program, including Mailware. Two of the most common
questions we receive are directly related to the stability of
the network on which Mailware is running. They are:

1. When I try to open more than one copy of Mailware I
receive the message: Directory is controlled by
other .NET file.  (See Deleting .Net and .LCK Files  p.
A.14).

2. The data I entered is missing/corrupt,  OR I received
one of the following messages: 

a. Index is out of date: Table.db
b. Corrupt or missing .VAL file
c. Detail table open operation failed

If you have entered Mailware’s network settings correctly
(see About Networking Mailware  p. ?.? ) the most likely
cause of the problems you are experiencing is related to
your network. This is usually the case even when other
programs are not reporting errors as most programs will not
present error messages even when their data is
compromised.

NOTE: Mailware’s error messages to do not indicate a
problem with Mailware itself. You do not need to reinstall
Mailware, or upgrade it. Rather, you can correct the problem
by using the following steps to optimize your network.

Mailware, and other programs that share data are
dependent on the stability of your network. Many variables
can affect this stability including; bad network cards, low
grade or overly long cables, incorrectly configured network
protocols etc. Listed below are the most common causes of
errors and methods for correcting them. Following these
steps will help ensure the integrity of your Mailware data.

Note : Mailware will display error messages when network
related errors occur. In some cases you will be unable to run
more than one copy of Mailware, in others your data may be
corrupted (Mailware includes a utility to fix corrupted data -
See Using the Database Repair Utility  p A.26 ).

Before attempting any of the following suggestions it is
highly recommended that you back up your Mailware data
first (see Backing Up Your Data  p. 4.24).

Also, please see About Networking Mailware  p. ?.? and
follow the instructions for setting up Mailware on a network,
especially the Control File directory, and BDE settings,
before proceeding. 

The following instructions apply primarily to Windows 95 and
NT. However, they can be used with Windows 98 with a
minimum amount of variation (for example, some items in
Windows 98 do not need to be double clicked).

.Net and .LCK files

Before testing your network for hardware or other problems
you should close all copies of Mailware and follow the
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instructions below to delete .Net and .LCK  files that may be than Mailware may create similar or even identical
on any or all of your PC’s. These files are used by files. You should be able to delete these files in any of
Mailware’s database to track who is accessing data. If you Mailware’s directories (including network data
are experiencing network problems these files may be directories) and the root directory of your C drive (C:\).
written to incorrect directories, or may not be deleted (as
they should be) when Mailware is closed. These files may 3. Repeat step 2 for all PC’s, then proceed to the
also be incorrectly written if Mailware’s network settings are following sections for help trouble shooting your
not correct (see About Networking Mailware  p. ?.?). network. Also, see  Miscellaneous Network

NOTE: You may need to repeatedly perform the following the error message: Directory is controlled by other
steps after making each of the recommended corrections to .NET file .
your network.

Deleting .Net and .LCK Files

1. Close all copies of Mailware.

2. Locate the following files using the Windows Find tool
and delete them:

a. PDOXUSRS.NET
b. PDOXUSRS.LCK
c. PARADOX.LCK

To locate the above files click the Windows Start
button, move the cursor to Find , then click Files or
Folders . In the Named  field in the dialog that appears
type: *.LCK;*.NET  In the Look In  field select My
Computer  from the drop down list. Then click the Find
Now  button. In the lower portion of the dialog click on
each of the above named files in turn and press the
Delete  key on your keyboard. If you receive a
message that a file is in use, or cannot be deleted
make sure ALL copies of Mailware and any other
programs are closed, then try again. Programs other

Troubleshooting Tips  p. A.22 for help circumventing

HARDWARE PROBLEMS

In even ideal networks an errant piece of hardware can
cause numerous problems. In most cases the culprit is a
bad ethernet card in a pc or printer. Correcting the problem
requires either sophisticated network traffic monitors
(“sniffers”), or simple trial and error. You should also run
Windows ScanDisk and Disk Defragmenter as well as any
third party software packages that verify system integrity
(i.e., Norton Utilities, First Aid etc.) on each PC.

The surest way to find a faulty device is to physically detach
all workstations and printers from a network, then reattach
PC’s one at a time (you can do so by shutting down each PC
then disconnecting the network cable). If you have no other
means for detecting a faulty piece of hardware you can use
Mailware to do so. Be sure to back up your data first .

Starting with just one PC (the server first if you have one, or
the PC where the data is installed) run Mailware. If the error
or corruption problems occur on a single PC, either it is the
culprit or Mailware is set up incorrectly (see How to Install
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Mailware  p. ?.? and About Network Installations  p. ?.? for longer than 300 meters. A 10/100baseT crossover
instructions on installing Mailware and setting it up on a cable that runs directly from one PC to another is not
network). sufficient for running a network. These cables are

If Mailware works fine with a single PC you can then add
one more, and begin using Mailware with two machines at 2. Check your hub  to ensure it is the right type for the
once. In this case the second PC will be accessing the data network you are using. 10mps hubs cannot be used
over the network. with 100mps ethernet cards. Your hub also should

If no errors occur you have eliminated two PC’s from the light is lit or flashing your network is experiencing
problem list, AND determined that your network settings are excessive packet collisions (i.e., lost data). This is
correct. usually a result of hardware problems or the use of

If you receive errors with 2 PC’s, and if you know your below).
network settings are correct, the problem may lie in one of
several hardware components: 3. Check the ethernet card in each PC. Either card, or

1. Check your cables  to ensure they are the correct may have run Mailware successfully even with a
ones for your network. Cables are either coaxial (like faulty ethernet card since it was being used locally).
those used for cable TV) or 10/100 baseT (similar to Many cards include diagnostic software you can run. 
thick phone cables). 

Coax cables  should be terminated at either end by a by clicking the Start  button, then Settings , then
small metal cap. They should also be professionally Control Panel . Then double click the System  icon.
tested to meet minimum OHM standards. If in doubt, Next click the Device Manager  tab. Click the + next
buy new cables. Coax cables should also be no to Network Adapters . Your card should be listed. If
longer than 50 feet - the shorter, the better. it has a red X next to it, it is not working properly.

10/100BaseT  cables should be rated Category 5, Click on the card once, then click the Properties
and must be connected through a hub. 10baseT button. The device status is listed in the center of the
cables are used for a 10mps ethernet card. dialog that appears (it should read: “This device is
100baseT can be used for either 10 or 100mps working properly.”). You can check the individual
cards. 100baseT cables must be connected to a hub settings by clicking the Resources  tab. Click on
that supports 100mps. These cables should not be each Resource Type  (i.e., Interrupt Request,

intended primarily for games.

have a Collision light (usually marked COL). If this

TCP/IP network protocols (see Network Protocols

both may be the problem at this point (the single PC

You can also view the card’s properties in Windows
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Memory Range and Input/Output Range). As you you can set NetBEUI as your primary protocol and alleviate
select each one the Conflicting Device List should some of TCP/IP’s packet dropping.
show “No conflicts.”

If your ethernet card does not meet all the above using the following steps. 
criteria you may need to reinstall it, or replace it.

Continue adding PC’s to your network one at a time, and network adversely (e.g., you may lose a connection to
repeat the above steps. If all your hardware checks out, the another PC or the Internet). You should make notes of the
problem may be in your Network Protocols. current settings so you can restore them if necessary

NETWORK PROTOCOLS

Windows networks are typically either NT Server  or Peer to
Peer. 

NT Server networks  include a PC that acts as the data
server and runs a copy of Windows NT Server. Workstations
on the network can run NT Workstation or Windows 95 or 98
clients.

Peer to Peer networks  do not include a copy of NT. They
are made up of workstations running Windows 95 or 98.

In both types of networks a Protocol is used to manage data.
Frequently TCP/IP is used, however NetBEUI and IPX/SPX
are also very common. It is also possible to have more than
one protocol.

If you have a choice, NetBEUI is the preferred protocol.
TCP/IP is not recommended due to its tendency to drop
packets (i.e., lose data). If you are connected to the Internet,
and need TCP/IP you can bind it to only your Dial Up
Connector. If you must bind TCP/IP to your ethernet card

You can check your network settings, and make changes

NOTE: Making the following changes may affect your

(double click each item in the dialog below and write down
the items on each tab). It is also recommended that you
back up your entire system before proceeding.

1. Click the Windows Start  button, then move the cursor to
Settings , and click Control Panel . Double click the
Network  icon in the window that appears. A dialog
similar to the following will appear:
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2. Double click your ethernet card in the list (e.g., PCI Fast
Ethernet Adapter  in the dialog above).

3. A dialog will appear. On it click the Bindings  tab. Listed
in the center will be the protocols bound to the card.
Preferably only NetBEUI or IPX/SPX should be used.
You can deselect protocols from the list by clicking the
checkboxes. When you click the OK button (and after
restarting Windows) the bindings will be removed. If
TCP/IP is listed it is recommended you deselect it, then
click the OK button. If you need TCP/IP you can leave it
selected. Later we will make NetBEUI the primary
protocol.

4. If NetBEUI  is listed skip to the next step. If it is not listed
you can add the protocol to your network. You will need
your Windows CD to perform this step. Click the Add
button on the bottom of the dialog. In the dialog that
appears double click Protocol . Windows will build a
database, then present another dialog. In the left pane
click Microsoft . In the right pane click NetBEUI . Then
click the OK button. Follow the on screen prompts which
will ask for the location of the Windows CD. When the
steps are completed close the original network dialog
with its OK button, and restart Windows when prompted.
You may also need to bind NetBEUI to your ethernet
card after restarting. Follow the steps above to open the
network dialog, then double click your ethernet card.
Click the Bindings  tab and select NetBEUI  by clicking its
check box. Click the OK button to save the changes.
When you are done go to the next step below.

5. Double click the NetBEUI  protocol that is bound to your
ethernet card (e.g., NetBEUI -> PCI Fast Ethernet Card).
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In the dialog that appears click the Advanced  tab. At the Database Engine (BDE) when Mailware is started. This file
bottom of the screen click the checkbox next to the line: should be created once, and should appear only in the
“Set this protocol to be the default protocol. ” Click the Control File Directory you specified when entering
OK button. After Windows is restarted NetBEUI will Mailware’s network settings (see About Network
become the default protocol. Installations  p. ?.?). In some cases, especially unstable

This step can be performed for IPX/SPX instead if your in the root directory of the C drive (C:\). When this occurs
network requires that protocol. the following error message appears on additional PC’s

6. In the network dialog other active protocols may be
listed. If you do not need them you can click each one in Directory is controlled by other .NET file
turn then click the Remove  button. You may have
multiple listings of protocols followed by the device to If you have optimized your network as described above, and
which they are bound (e.g., NetBEUI -> Dial Up are still having this problem you can enter an override in the
Connector). These may be removed in the same BDE to circumvent this problem.
manner. For most networks NetBEUI bound to your
ethernet card and TCP/IP bound only to your Dial Up 1. Click the Windows Start  button. Move the cursor to
Connector (for using the Internet) are sufficient. Settings, then click Control Panel.
Additional protocols or bindings may be causing
unnecessary traffic and lost data. 2. Double click the BDE Administrator  icon.

7. After completing the above steps, click the OK button on 3. In the dialog that appears click the Configuration  tab in
the network dialog. Windows will restart and your the left pane. Double click Configuration  if it is not
network settings will take effect. Test Mailware on the expanded. Then double click Drivers  and below it double
new network (as well as any other commonly used click Native . Single left click on Paradox .
programs) to ensure your network is operating correctly.
If you continue to experience lost data or error messages 4. In the right pane click on C:\ in the first line next to the
see the steps below for more assistance. cell labeled NET DIR. Click on the browse  button (...)

MISCELLANEOUS NETWORK TROUBLESHOOTING TIPS

Directory is controlled by other .NET file

The PDOXUSRS.NET file is created by the Borland

networks, the PDOXUSRS.NET file will appear on each PC

attempting to open Mailware:

that appears.

5. Browse to the directory you selected in Mailware as the
Control File Directory (usually the Network Database
directory). Double click the data folder, then click the OK
button. The NET DIR should now show the path to your
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Control File Directory (e.g., C:\Maildata\Data). workstations it looks like a drive letter on the server.

6. Click another field in the right pane (e.g., 3.0 next to matter of fact, no programs, including Mailware, should
VERSION) to exit the NET DIR field and enter the be run on the server even in a peer to peer network .
change (Note: the tab key will not exit the field, you must Running programs taxes the processor, and may cause lost
click another field with the mouse). data.

7. Close the BDE Administrator with the X in the top right An ideal network for Mailware  consists of an NT Server
corner of the dialog. When prompted answer Yes to save that manages the Mailware data directory with workstations
the changes. If Mailware is running you must close it, running Windows 95 or 98 clients. The network should be a
then reopen it to recognize the change to the BDE. 100mps ethernet using NetBEUI as the network protocol.

8. Repeat the above steps for each PC on the network.
Then close Mailware at each PC and delete any
PDOXUSRS.NET files that exist (see Deleting .Net and
.LCK Files  p. A.14).

The above steps will eliminate the message: “Directory is
controlled by other .NET file ”, however, you should
optimize your network as described above to reduce the
chance of data corruption caused by an unstable network.

About Network Data Servers

Network servers are repositories for your data. As such, and
contrary to popular belief, you should generally use your
least powerful PC. It should, however, be a Pentium class
processor with sufficient memory. As a rule, data should not
be stored on the C drive. Partitioning a single drive into
multiple logical drives works fine, or you can use multiple
hard drives.

In most cases you will store your Mailware data on the data
server. The data directory can be mapped so that to your

Mailware itself does not need to reside on the server. As a

SUMMARY

Networks are tricky. A lot of data is being passed around,
and like a busy highway - the more traffic, the more likely an
accident. By optimizing your network as described above
(thereby reducing traffic), and by following good network
practices, like regularly backing up your data, you can
expect far fewer problems and greater productivity.

Your network is a valuable asset to your business. Mailware
and many other programs depend on it to operate properly.
If your network is not stable not even the best program will
perform well. And, unlike Mailware, many will not warn you
until your data is already lost.

If you are not comfortable managing your network many
competent consultants are available to set one up. They can
also install maintenance programs (e.g., Norton Utilities) and
scheduled tape back ups to help ensure a smooth operating
environment, and to provide emergency recovery tools.
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USING THE DATABASE REPAIR UTILITY

This utility can be used to repair Mailware's databases if
they become corrupt (corruption usually occurs when a
computer is turned off or rebooted while tables are open, or
when Mailware is used on an unstable network).

Mailware will display an error message when a table is
corrupted. The most common error messages follow:

1. detail table open...operation failed: Table.db
2. Index is out of date: Table.db
3. Corrupt or missing .VAL file
4. Detail table open operation failed

Some will be followed by the name of the affected table (for
example, orders.db) You can run the repair utility and select
each reported database table for repair.

IMPORTANT NOTE:  Before using the following procedures
you should back up your data. You can use a backup device
(e.g, a tape drive or Zip disk drive), or simply copy the
Mailware Data directory (default is C:\MAILW15\DATA) to
another hard drive (see Backing Up Your Data  p. 4.24)

QUICK START INSTRUCTIONS FOR RUNNING THE
DATABASE REPAIR UTILITY

1. Run the setup.exe file in the Database Repair Utility
directory on the CD, or choose the Database Repair
Utility option from the Installer.

2. To use the Repair Utility, run it from its icon in the
Mailware Program group. Click the By Directory  button

to select  individual tables in your Mailware Data directory
(e.g., Ads.db  is a table). Then click the Verify  button.

3. If the utility does not report that the table "has no errors"
click the Rebuild  button to fix it. Repeat the process for
all suspect tables (usually those listed in the error
message as described above).

FULL INSTRUCTIONS FOR RUNNING THE DATABASE
REPAIR UTILITY

1. Exit Mailware, and any other open programs. If the repair
utility is already installed skip to step 5 below. Otherwise,
insert the Mailware CD. If autostart is active on your
system, the Welcome screen will appear after several
seconds. Click Launch the Installer.

2. Choose the Database Repair Utility  option from the
menu that appears (you may need to click the More >
button to see it).

3. Follow the on screen instructions to install the utility.

4. Close the Installer and Mailware if it is running.

5. Run the Database Repair Utility  from its icon in the
Mailware program group (Click the Windows Start
button, move the cursor to Programs , then to Mailware .
Click the Database Repair Utility  item.).

6. On the dialog that appears click the By Directory  button.
A browse window will pop up. Browse to the Mailware
data directory (the default directory is
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C:\MAILW15\DATA), and find the file name that
appeared in the error message you received (e.g., Help Shortcuts
orders.db), or any file with an extension of ".db" and
double click it. Ctrl-F1 Opens the help Search window. This works both in

NOTE: If you are running Mailware on a network be sure I Opens the topics Index window
to browse to the network directory (default is S Opens the Search window (Windows 3.x owners
C:\MAILDATA\DATA). You can check which database use Alt-S)
you are using by opening Mailware and choosing File X Exits Help
then Open Company  from the text menu. Z Opens the Shazam Report Writer Help window

7. Click the Verify  button on the utility. After a moment it will
report in the message line that the Verification was
Successful (the table is good), or that it could not verify Mailware Keyboard Shortcuts
the table (the table is corrupt).

8. If the table is corrupt, or if you are not sure, you can click both in help and in Mailware.
the Rebuild  button to repair it. F1 Opens Help Contents or context sensitive help for

9. Close the utility and run Mailware to check for any F2 Lookup a field in a drop down box
additional errors. You can repeat the above for any files F5 Shows the Company Database window
with an extension of .db Alt Accesses the text menu (then press the underlined

Visit our web page for updated support tips at: Ctrl-P Print the current form
www.Mailware.com Ctrl-X Cut the currently selected text to the clipboard

help and in Mailware.

Ctrl-F1 Opens the help Topic Search window. This works

the current topic.

letter of the item you wish to use e.g. F for File.)
Ctrl-F Opens the Find dialog

Ctrl-C Copy the currently selected text to the clipboard
Ctrl-V Paste text from the clipboard into the currently

selected field
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Mailware Toolbar Shortcuts are currently using (the active form). For example, you will

Add a Customer - Opens a blank customer form.

Find a Customer - Opens the search form.

Add a New Order

Find an Order

Opens the Product form

Opens the Product Supply Vendors form

Opens the Purchase Order form

Begins Processing of Open Orders

Begins Processing of Credit Card transactions

Opens the Import Wizard

Opens the Shazam Report Writer so you can create a
report

Opens the Shazam Report Explorer

Brings the Company Database window to the front

Opens Help Contents

The following buttons appear when needed for the form you

see these buttons when you are using the Customer form.

Adds an item to the active form (e.g., add a customer
while in the customer form)

Edits the selected item in the active form (e.g., edit a
product while in the product form)

Immediately saves your changes to the current record
without closing the form.

Jumps to the first item in the active form

Moves back one item in the active form

Moves forward one item in the active form

Jumps to the last item in the active form

Opens the Search dialog for the active form (use to
find a specific item)

Opens the Filter dialog for the active form (use to
view only records that match criteria you specify)

Lookup a field in a drop down box

Cancels changes made to the currently selected
record without closing the form

Deletes the currently selected record (you will be
asked for confirmation - Caution: after confirmation
the deletion is permanent)
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